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1 Introduction

The Fabasoft Personnel File provides electronic management of personnel files in a central
location. You can either record the mandatory personal data via the web browser interface or
use the import mechanism. Additionally, you can store documents of a personnel file in a
folder hierarchy of your choice. Dashboards offer a comfortable and quick overview of your
personal files.

support
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2 Getting Started with your Personnel File

A prerequisite for the use of the personnel file is that the “Personnel File” service package is
activated. In addition, the service packages “Personnel File (Access)” and “Skills Management”
are available as optional extensions.

If you are the organization owner, organization administrator, or personnel file administrator,
you will find topics on setting up and administering the personnel file in chapter 17
“Administration Tasks".

If you are a personnel file user, see topics about using the personnel file from the next chapter
onwards.

3 Structuring Elements of the Personnel File

The structuring elements of the personnel file are:

«  Personnel File (Dashboard)
For end users the dashboard is the access point to the personnel file.
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» Personnel File Configuration
In the personnel file configuration common settings, the structure of personnel files and
the personnel file users (licensing) are defined.

«  Personnel File Shelf
The personnel file shelf is based on a personnel file configuration, but the defined settings
can be overwritten or extended. The personnel file shelf is used to manage the personnel
files and to specify the access rights.

e Personnel File
A personnel file is assigned to a person who is standing in an upright employment
relationship with the company or will be or was in such an employment relationship.
Besides the possibility to enter metadata, documents can be stored.

e Personnel File Folder
Personnel file folders are used for structuring personnel files. Besides the predefined
folders that are defined in the personnel file configuration or personnel file shelf,
additional personnel file folders can be created ad hoc.

o Business Case Shelf
In a business case shelf, business cases and documents are managed, which are not
assigned to a single personnel file. Bulk documents can be used to generate and store
individual documents for each personnel file.

»  Personnel File Collection
A personnel file collection can be created in a Teamroom and can be used to collect
personnel files that are relevant for the user.
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4 Personnel Files (Personal Dashboard)

The personnel files dashboard provides the access point to the personnel file for end-users.

When you are added as a personnel file user to a personnel file configuration, a dashboard is
automatically created and placed on “Home". If you are removed as a personnel file user, the
dashboard is removed, too.
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4.1 Dashboard

The personnel file dashboard is divided in following areas:

o Recently Used Personnel Files
Shows the personnel files that have been recently used by the user.

o Recently Used Documents
Shows the documents that have been recently used by the user.

e Inconsistent Personnel Files
Shows inconsistent personnel files if the consistency check is configured.

o Active Employees
Shows the number of active employees in the last twelve months.

o Entries/Leaves
Shows the number of entries and leaves in the last twelve months.

D Turnover
Shows the turnover of staff in the last twelve months (Schliter formula).

e Report Results
Shows the generated Excel/BIRT reports (see section 17.2.2).
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Organizational Structure
Shows the organizational structure that can be used to assign personnel files to positions.

Personnel File Shelves
Shows the personnel file shelves that are used to manage the personnel files.

Business Case Shelves
Shows the business case shelves that are used to manage the business cases.

Note: The statistics are only available, if the setting Calculate Statistics of the personnel file
shelf is activated. By default, the data is updated once a day. With the “Update Statistics”
context menu command of the personnel file shelf the data can be updated manually.

4.2 Actions

You can execute following actions:

Create Personnel File
With the “Create Personnel File” action you can create new personnel files. For more
information, see chapter 6.1 “Create Personnel File”.

Import Personnel Files
With the “Import Personnel File” action you can import or update personnel files using a
CSV file. For more information, see chapter 6.2 “Import Personnel File”.

Register Documents

With the “Assign Documents” action you can register documents (which are already in the
system) to personnel files using a CSV file. For more information, see chapter 8.15
“Registering Documents Automatically”.

Switch to Configuration
With the “Switch to Configuration” action you can open the personnel file configuration.

Settings
With the “Settings” action you can define common properties of the personnel files
dashboard like the logo or notification setting.
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5 Personnel File Sh

elf

The personnel file shelf is used for the management of personnel files and predefines the folder

structure of personnel files.
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5.1 Dashboard

e Personnel Files

Shows the active and inactive personnel files of the personnel file shelf. Active means that
an upright employment relationship with the company exists. Inactive means that the

entry date is in the future (predefined personnel files) or the separation date is in the past.

e Inconsistent Personnel Files
Shows inconsistent personnel files if the consistency checkis configured.

o Active Employees

Shows the number of active employees in the last twelve months.

o Entries/Leaves

Shows the number of entries and leaves in the last twelve months.

. Turnover

Shows the turnover of staff in the last twelve months (Schliter formula).

e Scan Queuve (only visible if at least one pre-captured document exists)
Shows the pre-captured documents in which no scanned content has been uploaded.
Note: Your system administrator has to configure the scanner software accordingly such
that the documents can be imported via a web service.

e Report Results

Shows the generated Excel/BIRT reports of the personnel file shelf (see section 17.2.2).

Fabasoft
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Closed Personnel Files
Shows the closed personnel files of the personnel file shelf. Closed personnel files cannot
be changed.

Canceled Personnel Files
Shows the canceled personnel files of the personnel file shelf.
Note:

o Canceled personnel files can be permanently deleted by users with “Full Control”, if no
retention rules are violated.

o Ifthere are more than 2000 personnel files in the list, the oldest cancelled personnel
files are archived.

Thesauri

Shows the thesauri in which terms for tagging of documents can be managed. At least
one thesaurus has to be created in the personnel file configuration or personnel file shelf
so that the tagging can be used. The default thesaurus for new terms is defined in the
settings of the personnel file configuration or personnel file shelf. Thus, new terms can be
created directly in the tagging process. If no standard thesaurus is specified, only the
predefined terms in the thesauri can be used. The default thesaurus of the personnel file
shelf is preferred to the default thesaurus of the personnel file configuration.

Note: The statistics are only available, if the setting Calculate Statistics of the personnel file
shelf is activated. By default, the data is updated once a day. With the “Update Statistics”
context menu command of the personnel file shelf the data can be updated manually.

5.2 Actions

You can execute following actions:

Create Personnel File
With the “Create Personnel File” action you can create new personnel files. For more
information, see chapter 6.1 “Create Personnel File”.

Import Personnel Files
With the “Import Personnel File” action you can import or update personnel files using a
CSV file. For more information, see chapter 6.2 “Import Personnel File".

Register Documents

With the “Register Documents” action you can register documents (which are already in
the system) to personnel files using a CSV file. For more information, see chapter 8.15
“Registering Documents Automatically”.

Download Birthdays Report

The context menu action "Download Birthdays Report" can be used to download an Excel
report that lists all birthdays for today and the next 10 days. To do this, you need "Change
Access" or "Full Control".

Note: The report can be updated via the "Update Statistics" context menu.

Download Anniversaries Report
The context menu action "Download Anniversaries Report" can be used to download an
Excel report that lists all anniversaries for today and the next 10 days. To do this, you need
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"Change Access" or "Full Control".
Note: The report can be updated via the "Update Statistics" context menu.

Settings
With the “Settings” action you can change the settings of the personnel file shelf. For
more information, see chapter 17.3 “Personnel File Shelf".

Permissions
With the “Permissions” action you can define access rights for the personnel file shelf. For
more information, see chapter 15.1 “Define Permissions (Personnel File Shelf)".

5.3 Unstructured Shelves

With the context menu entry "Use Queried Lists for Personnel Files" of a personnel file shelf, it is
possible to change a shelf to an unstructured or query-based view. To switch back to the
structured view, there is the context menu entry "Use Saved Lists for Personnel Files".

The following lists are now unstructured/query-based:

Personnel Files

Closed Personnel Files

The following menus are available in the query-based lists:

Search
The search function can be used to search for and restrict personnel files.

Refresh
The list of personnel files is updated.

Further search functions
Search patterns can be loaded, saved and reset.

Note:

It only makes sense to switch to this display if there are more than 10,000 personnel files.

The search only finds personnel files that are in the list. You cannot search for closed
personnel files in the "Personnel files" list.

If the search is not restricted, the first 10,000 personnel files are displayed in the lists.

The following functions are not possible with an unstructured shelf:

o Reports

No reports from "All Personnel Files", "Closed Personnel Files", "Active Personnel Files"
and "Active and Closed Personnel Files" can be generated if there is at least one
unstructured shelf. This applies both to the evaluation area of the personnel file
daoshboard and to the evaluation area of the personnel file shelf.

o Show Missing Qualifications

The menu is no longer displayed if there is at least one unstructured shelf.

o Perform Consistency Check

The menu is no longer displayed on the shelf or on personnel files within this shelf if it is
unstructured. If there were inconsistent personnel files before the switch to query-
based view, these are no longer marked as inconsistent after the switch.
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o When reqgistering a document, the hierarchy view is hidden in the "Personnel File" field
if there is at least one unstructured shelf.

6 Personnel File

A personnel file is assigned to a person who is standing in an upright employment relationship
with the company or will be or was in such an employment relationship.

00000001 - Yang, Aaron (Personnel File): Edit

Master Data

Master Data

Contact Data

Herr

Skills Aaron Yang, MSc
Neue Weide 23

2191 NASSFELD
OSTERREICH

Access
General

Remarks
Edit Remove

Versions

Personnel Number *

Retenti 00000001 + Managed Externally
etention

Security Surname * First Name
Yang Aaron

Title Post Title
MSc

|_calutatian

Besides the possibility to enter metadata, documents can be stored in a personnel file. In a
personnel file, an overview of all documents of the personnel file is displayed on top-level. The
tree view can be used to navigate in the several personnel file folders.

Personnel files, personnel file folders and documents are filtered, if the user has no access
rights.

6.1 Create Personnel File

To create a personnel file, perform the following steps:

1. Navigate in the personnel file dashboard or in the desired personnel file shelf.
2. Click the “Create Personnel File" action.

3. Ifyou arein the personnel file dashboard and several personnel file shelves exist, select the
desired personnel file shelf.

4. Enter the data on the “Master Data”, “Contact Data” and “Access” tab. At least the
surname has to be specified.

o Ifthe personnel number is not generated automatically, you have to enter it manually.
When using the manual assignment you can also enter additional personnel numbers.
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o Onthe "Access” tab, in the Assigned Userfield you can enter a user who corresponds
with the personnel file and should get read access.
In the Supervisors field, you can enter users/organizations that should get read access
to all personnel files of their subordinates.
Note: If it is configured that users are taken over from the organizational structure the
fields are displayed read-only.

5. Click “Next".

More information about accessing personnel files as employee or supervisor can be found in
chapter 15.3 “Personnel File".

Note: Personnel files can only be created if a Folder Structure for Personnel Files is defined in
the personnel file configuration.

6.2 Import Personnel Files

Personnel files can be imported and updated using a CSV file.
To import personnel files, perform the following steps:

1. Navigate in the personnel file dashboard or in the desired personnel file shelf.
2. Click the “Import Personnel Files” action.

3. Optionally, click the “Download CSV Template” button to retrieve a template that
describes the necessary data structure.

4. Enter the path to the CSV file in the Contentfield.
5. Click “Start Import”.
6. After the import has finished, click “Next”.

The personnel files are stored in the personnel file shelf.
Note:

« Forthe personnel file import, a manual assignment of personnel numbers is required
(settings of the personnel file shelf > “Numbering” tab > Generate Personnel Number
Automatically > "No").

« To prevent that fields (that should be updated by an import) are changed directly in the
personnel file using the user environment, it is possible to set the corresponding fields
read-only via the personnel file configuration or personnel file shelf on the “General
Settings” tab, in the Externally Managed Master File Data field. This applies only to
personnel files for which the “Managed Externally” option is enabled.

« Incase of an error in a personnel file, the lines concerning the same personnel number are
ignored.

« Ifthe personnel file shelf is unstructured, the imported files are only displayed when the
list is updated and if there is no search pattern that excludes the Ffiles.

The CSV columns are in general free-text fields of type string, number or date (yyyy-mm-dd). The
Fabasphere ID can be found on the “General” tab of the corresponding object. The import ID
can be used to update objects and assign these objects to other objects. Following CSV
columns are available:
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CSV Column Field Possible Value

PersNum Personnel Number String

FileShelfId Personnel File Shelf Fabasphere ID or Import ID (has
to be specified if the import is
carried out not in context of a
personnel file shelf)

Surname Surname String

FirstName First Nome String

Sex Sex 1, 2 or 103 (male, female or
diverse)

Title Title String

PostTitle Post Title String

CommLanguage Language for Communication Reference of a system language
(e.9. LANG_GERMAN, LANG_ENGLISH)

Salutation Salutation String

Birthday Date of Birth Date

SocialSecId Social Security Number String

PreviousNames All Previous Names String

ImageTeamroom Teamroom that contains Fabasphere ID of a Teamroom

employee photo

ImageName Photo Object name of an image

EntryDate Entry Date Date

SeparationDate Separation Date Date

Birthplace Birthplace String

Nationality Nationality String
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Denomination Denomination String
Company Company (Textual) String
Orgunit Organizational Unit (Textual) String
Street Address (Street) String
ZipCode Address (Zip Code) String
City Address (City) String
State Address (State) String
Country Address (Country) String
AddrTopic Address (Topic) Reference of a topic (e.g.
TermBusiness, TermPrivate)
Emaill E-Mail Address (Topic: E-Mail 1)  String
Email2 E-Mail Address (Topic: E-Mail 2)  String
Email3 E-Mail Address (Topic: E-Mail 3)  String
Phone Telephone Numbers (Topic: String
Business)
Fax Telephone Numbers (Topic: Fax)  String
Mobile Telephone Numbers (Topic: String
Mobile)
PrivatePhone Telephone Numbers (Topic: String
Private)
BankAccountHolder  Account Holder String
Iban IBAN String
Bic BIC String
Qualification Qualification Import ID of the qualification
(skills management)
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QualificationlLevel |evel Import ID of the rating scale
value of the qualification (skills
management)

RoleDescription Role Descriptions Import ID of the role description
(skills management)

FullTimeEquivalent Fy[l-Time Equivalent (in Percent) Number

UserId Assigned User Log-in name of the user (user
object)
SupervisorId Direct Supervisor E-mail address or Fabasphere ID

of the user (user object)

AllSupervisorIds Supervisors E-mail addresses or Fabasphere
ID of the users (separated by “|")

AdditionalPersNums Additional Personnel Numbers String

Remark Remark String
GrossIncomeSymbol  Gross Income (currency) String (e.g. EUR, USD)
GrossIncomeValue Gross Income (value) Number

Assignments Assignments Import ID of assignments,

separated by commas

OverrideKeys - CSV columns of properties to be
overwritten separated by
commas (otherwise empty values
are ignored and values are
added in list properties)

Note:

» To populate fields that can consist of several rows (e.g. Address), it is possible to specify
several rows in the CSV file with the same personnel number (PersNum). If the FileShelfId
is used, it has to be specified for each line.

o Ifitis defined in the personnel file configuration that unique personnel numbers should be
used across all personnel file shelves, existing personnel files (Persnum) can be moved by
specifying a different Fileshelf1d.

o If a user-defined form is assigned to personnel files, these properties can also be
imported (the programming name of the respective property serves as the column
caption).
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» Ifseveral rows with the same personnel number (persnum) but different personnel file
shelves (Fileshelf1d) exist, a primary personnel file shelf is determined as described
below. All rows that do not correspond to this primary personnel file shelf are ignored.

o The lines with an active employment relationship are preferred.

o Inthe case of several active or inactive employment relationships, the line with the
most recent entry date is preferred.

o Rows without an entry date are considered older than rows with an entry date.

o Ifthere are several rows without an entry date, the first row found is used.

6.3 Upload

With the “Upload” action, you can store files in the personnel file shelf. For more information,
see chapter 8.7 "Uploading a Document”.

6.4 Scan

With the “Scan” action, you can scan documents and directly store them in the personnel file
shelf. For more information, see chapter 8.5 “Scanning a Document”.

6.5 Pre-Capture

With the “Pre-Capture” action, you can pre-capture documents for an automatic scan. For
more information, see chapter 8.6 “Pre-Capturing a Document for a Scan”.

6.6 Create Personnel File Folder

If it is defined in the personnel file configuration or in the personnel file shelf that personnel file
folders may be created on top-level, you can add personnel file folders with the “Create
Personnel File Folder” context menu command. For more information, see chapter 7.1
“Creating a Personnel File Folder”.

6.7 Show New Events

In order to be able to follow changes over time of personnel files, an own overview of the
history is available that can be viewed from different angles.

To view events, perform the following steps:

1. Navigate to the desired personnel file.

2. Click the “Show New Events” action.

An overview of the recent events is displayed. The “Timeline” tab visualizes the time course;
the “"History” provides a textual overview. The other tabs represent different groupings.

Notifications about new events
Notifications can be displayed in the welcome screen or can be subscribed via e-mail.
To define notification settings, perform the following steps:

1. Inthe user menu click “Notifications”.
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2. Click the “Settings” button.

3. Choose about which changes and how you want to be notified. For the personnel file an
own area is provided.

4. Click "Save”.

6.8 Properties

To edit a personnel file, perform the following steps:
1. Navigate to the desired personnel file.
2. Click the "Properties” action.

3. Enter the desired data and click “Next”.

Note: To access the documents of a personnel file, click on the personnel file or execute the
“Open” context menu command.

Besides the usual master and contact data of an employee, you can also specify the following:
“Master Data” tab

*  Managed Externally
To prevent that fields (that should be updated by an import or via the SAP integration) are
changed directly in the personnel file using the web environment, it is possible to set the
corresponding fields read-only. The affected fields are defined in the personnel file
configuration or shelf.

“Salary” tab

e Current Gross Salary
Shows the current gross salary (according to the salary history).

e Salary History
Defines the gross salaries in the context of a validity period.

“"Access” tab

o Assigned User
In this field, you can enter the employee to whom the personnel file is assigned. This
allows viewing the documents intended for employees.

e Direct Supervisor
In this field, you can specify the direct supervisor. This allows viewing the documents
intended for supervisors.

e Supervisors
In this field, you can specify all higher-level supervisors in the hierarchy. This allows
viewing the documents intended for supervisors.

Note: If it is configured that users are taken over from the organizational structure the fields are
displayed read-only.

More information can be found in chapter 11 “Personnel File Access” and 15.3 “Personnel File”.

~Assignments” tab
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e Company
Shows the company that is stored for the associated organizational position.

e Location
Shows the location that is stored for the associated organizational position.

e Personnel Area
Defines the associated personnel area.

e Personnel Sub Area
Defines the associated personnel sub area.
Note: The property is only visible if a personnel area has previously been defined.

»  Employee Group
Defines the associated employee group.

Employee Circle
Defines the associated employee circle.
Note: The property is only visible if an employee circle has previously been defined.

e Organization Key
Defines the associated organization key.

6.9 View as PDF

For metadata of a personnel file and associated documents, a PDF overview can be
generated. If a watermark is defined in the personnel file configuration or personnel file shelf,
the watermark is added to the document.

To view the personnel file as PDF, perform the following steps:

1. Navigate to the desired personnel file.

2. On the context menu of the personnel file, click “View as PDF”.
The generated PDF document will be opened automatically.

Note: With the “View List of Contents” context menu command, you can generate a PDF
overview without the document contents.

6.10 Closing a Personnel File

Personnel files with a defined separation date can be closed. When closing a personnel file
also the assigned documents are closed. After closing, no further changes are possible.
However, canceled documents can still be deleted.

For retention-worth documents, the retention period is calculated and applied on the basis of
the retention rule defined in the category. The retention period cannot be shortened anymore.

To close a personnel file, perform the following steps:

1. Navigate to the desired personnel file.

2. On the context menu of the personnel file, click “Advanced” > “Close”.
3. Click "Next" to display the overview of the personnel file.
4

Before closing, you can clean up the personnel file and deal with unwanted documents on
the “Documents” and “Canceled Documents” tabs.
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5. Click "Close".
Note: If the document contains canceled documents with a category that defines a
retention worthiness, a corresponding message is displayed. Click on “Remove Categories
and Close” to remove the categories because no retention period can be applied to
canceled documents.

The closed personnel file is stored in the “Closed Personnel File” field. The state “Closed” can
be removed again using the “Advanced” > “Remove ‘Closed’ state” context menu command.
This allows the personnel data to be changed again. The additional operations carried out
during the closing, such as the closing of documents or the calculation of the retention period
cannot be reversed.

Activity “Close File"”

You also have the option to start a process for closing a personal file. To do this, execute the
context menu command “Tools” > “Start New Process” on the personnel file and select the
“Close File"” entry in the “Prescribed Activity” field. The selected process participant has the
possibility to close or not close the personnel file.

6.11 Canceling a Personnel File

Personnel files can only be removed from the personnel file shelf with the “Cancel Personnel
File" command.

To cancel a personnel file, perform the following steps:
1. Navigate to the desired personnel file.
2. Onthe context menu of the personnel file, click “Advanced” > “Cancel”.

3. Click "Yes" to confirm the cancellation.

The canceled personnel file is stored in the “Canceled Personnel File” field. Canceled
personnel files can be restored using the “Advanced” > “Restore” context menu command.
Users with “Full Control” can also delete personnel files permanently (“Delete” command and
removing from the wastebasket), if no retention rules are violated.

6.12 Changing the Assignment of a Personnel File

Personnel files can be moved from one personnel file shelf to another. Depending on the
settings of the current personnel file shelf a copy of the personnel file is kept in the current
personnel file shelf.

To change the assignment of a personnel file, perform the following steps:
1. Navigate to the desired personnel file.
2. On the context menu of the personnel file, click “Advanced” > “Change Assignment”.

3. Select the new personnel file shelf and define the personnel number if applicable. If it is
configured that a copy remains in the current personnel file shelf you have to define the
personnel number of the copy, too.

4. Click "Next".

5. Define the settings which should be updated for the personnel file and click “Next”.
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6.13 Working With Follow-ups

When using the follow-up functionality an e-mail can be sent to a user at a particular time. The
follow-up may be defined for personnel files and individual documents.

To define a follow-up, perform the following steps:

1. Navigate to the desired object.

2. On the context menu of the object, click “Tools” > “Create Follow-Up"” or “Manage Follow-
Ups” (at last one follow-up is already defined).

3. If you mark the follow-up as personal (only valid for the "Send e-mail" action), it will not be
visible to other users.

4, Selectthe Actionthat should be executed.

o Send E-Mail
Define Recipients for the e-mail. In the Message field, you can specify the e-mail text.

o Start Process
Define the process that should be executed.
Note: The process has to be released for the organization.

5. Define the date of the follow-up. You can either specify an explicit date or let the date be
calculated based on a base date field of the object. In addition, you can define whether the
date should be recalculated if the base date value changes. This is mandatory if the base
date does not yet have a value.

6. Click “Next".

Upon reaching the follow-up date and after processing the automatic task the defined action
will be executed.

6.14 Working With Automatic Follow-ups

If a document needs to be reviewed or renewed after a certain period of time, follow-ups are
offered.

A follow-up can be defined manually via the context menu or the category that is assigned to
the document already defines default follow-ups. For this purpose, in the category, in the
Default Follow-Ups field a corresponding follow-up has to be assigned.

Sending the follow-up is based on the Time Interval and the Base Date. The base date may
refer either to a date field of the document or to a date field of the assigned personnel file.

Note:

« The assigned follow-ups are canceled when removing a category.

« |If the default follow-ups of a category are changed, the changes can be propagated to
the documents via the “Update Settings” context meu command of a personnel file shelf.

6.15 Displaying Master Data of an Employee in SAP

To display the master data of an employee in SAP, perform the following steps:

1. Navigate to the desired personnel file.
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2. On the context menu of the personnel file, click “Open SAP Personnel Master Data”.

The master data is displayed in SAP.

6.16 Access Using the File System

Personnel files can be accessed via the WebDAV protocol using the file system. To do so you
have to connect a network drive in your file system browser with following URL:
https://<server>/<vdir>/webdav

Example: https://at.cloud.fabasoft.com/folio/webdav

In the file system operations like adding or removing documents are possible.

7 Personnel File Folder

Personnel file folders are used for structuring personnel files. Besides the predefined folders
that are defined in the personnel file configuration (see chapter 17.2.1 “Dashboard”) additional
personnel file folders can be created manually.

7.1 Creating a Personnel File Folder

To create a personnel file folder, perform the following steps:

1. Navigate in the desired personnel file. You can only create personnel file folders on top-
level, if it is correspondingly configured in the personnel file configuration or personnel file
shelf. If applicable, navigate further to an existing personal file folder to create a new one
within this folder.

2. Open the context menu of the personnel file or personnel file folder in the tree view and
click the “Create Personnel File Folder”.

3. Enter a Name and possibly a Subject.
4, Click "Next".

Predefined personnel file folders differ from manually created personnel file folder by a lock
symbol.

7.2 Editing a Personnel File Folder

To edit a personnel file folder, perform the following steps:

1. Navigate to the desired personnel file folder.
2. On the context menu of the personnel file folder, click “Properties”.

3. Enter the desired data and click “Next”.
Following fields are available:
“personal File Folder” tab

o Multilingual Name
The name of the personnel file folder. This can be specified in several languages. When
changing the language in the basic settings, the name of the folder also changes.
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Subject
A description of the personnel file folder.

Category
The category of the personnel file folder.

Predefined Folder
Shows whether it is a predefined personnel file folder.

Personnel File
The personnel file folder is assigned to the personnel file that is shown in this field.

“Available Categories” tab

Available Categories
The defined categories can be assigned to documents of the personnel file folder. Only
categories can be selected that are allowed in the superordinate hierarchy.

Note: When editing a personnel file folder (template) in the personnel file configuration,
configuration-specific fields are provided (see chapter 17.2.1 “Dashboard”).

7.3 Canceling a Personnel File Folder

Manually defined personnel file folders can be canceled, if they are empty.

To cancel a personnel file folder, perform the following steps:

1. Navigate to the desired personnel file folder.

2. On the context menu of the personnel file folder, click “Advanced” > “Cancel”.

3. Click "Yes" to confirm the cancellation.

Note:

Canceld personnel file folders can be found in a personnel file (“Properties” action) on the
»,Canceled Documents” tab. The tab is only visible if at least one personnel file folder or
document is canceled.

Canceled personnel file folders can be put into the wastebasket by users who have at
least change rights. Users with full control can permanently delete the documents, if no
retention rules are violated.

8 Documents of a Personnel File

Documents in a personnel file are stored in personnel file folders in a structured way.

For storing documents in a personnel file several possibilities are available:

Create document

Scan document

Pre-capture document

Import document (e.g. drag and drop)

Register document
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Note: Documents can only be stored in personnel file folders not directly in the personnel file.
However, you can still create document at top-level, because the implicit registration of the
document requires selecting a personnel file folder.

8.1 Processing State

Each document has a processing state:

e InProgress
Documents that should be changed after creating them (e.g. objective agreements) have
to have the “In Progress” state. The state is visualized by a blue arrow as symbol.

» Closed
The content of a closed document cannot be changed anymore. When closing a
document a final form is generated and a version is stored. Closed documents cannot be
set in progress anymore.

* Replaced
A Document that has been replaced by another document gets the “Replaced” state.

» Canceled
When canceling a document the “Canceled” state is set.

Note: When scanning or uploading a document the state is set to “Closed” by default. If the
state should be “In Progress”, you have to unmark the Close Documentfield.

State transitions:

New State In Progress Closed Canceled
Old State
In Progress no yes yes
Closed no no yes
Canceled yes (by recovering the  yes (by recovering the yes
old state) old state)

8.2 Personnel File Document

A personnel file document can contain several documents (even of different types). Depending
on the use case, you can use documents (for example, Microsoft Word document) and
personnel file dJocuments in the personnel file environment.

To create a personnel file document:

1. Navigate into the desired personnel file or personnel file folder.
2. Open the background context menu by right-clicking in the free area and select “New.

3. Inthe dialogue that opens, choose the “Personnel File Document” object class, provide a
name and click “Next”.
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4. Fillin the requested data to register the personnel file document you created. In the
“Documents” field, you can add one or more files to be included in the personnel file
documents.

5. Note: One document in the personnel file dJocument can be defined as the main document.
To do this, just select it from the “Main Document” drop-down list.

6. Click “Save”. The personnel file dJocument has been created and registered.
Notes:

«  When editing a personnel file document, the main document is opened. You can edit the
other documents using the properties of the personnel file document (“Personnel File
Document” tab > Documents). If you choose however to sign the document or print it with
a QR code by selecting the respective options in the context menu of the personnel file, all
included documents are displayed.

o Itis possible to create also personnel file document templates for example in the
configuration of the Personnel File app or in the settings of a personnel file shelf. To read
more about the definition of templates, visit “Defining Templates”.

8.2.1 Make the Use of Personnel File Documents Mandatory

If the "Make the Use of Personnel File Documents Mandatory" setting is activated in the
configuration or on a shelf, only personnel file documents can be created in a personnel file.
When a document is registered, it receives a personnel file document cover and the document
is used as the main document. If several documents are registered at the same time, you can
decide whether the documents are filed as individual personnel file documents or summmarized
together in one personnel file document.

Note: With the setting "Make the Use of Personnel File Documents Mandatory" on a shelf, it is
possible to overwrite the configuration settings.

8.3 Creating a Document

To create a document, perform the following steps:

1. Navigate into the desired personnel file or personnel file folder.

2. Open the background context menu by right-clicking in the free area. Then click “New”.
3. Select the desired document, enter a name and click “Next”.
4

Register the document to the personnel file by entering the metadata.
Note: If you are in a personnel file folder, it is already preselected.

5. Click “Save”.

The document is stored in the personnel file folder and can be edited in the corresponding
third-party product (“Edit” context menu command).

8.4 Editing a Document

To edit a document, perform the following steps:

1. Navigate in the desired document.
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2. Onthe context menu of document, click “Edit".

Note: Metadata of personnel files can be inserted as updateable fields in associated Word
documents. The “Property” button is available in Microsoft Word on the “Insert” tab (the
Fabasphere COM Add-in has to be enabled).

8.5 Scanning a Document

To scan and import a document directly on the device, perform the following steps:

1. Navigate in the desired personnel file or personnel file folder.
2. Click the “Scan” action.

3. Scan the document.
Note: The scanner software has to be configured such that the scanned document is
copied to the clipboard. If the scanner software does not support this directly, you can
define the program copytoclipboard in the post-processing steps of your scanner
software. The program can be downloaded from the scan dialog.

4. After the document has been copied to the clipboard, click “Yes” to confirm the upload of
the document.

5. Ifyou are at top level in a personnel file, select the desired personnel file folder in which the
document should be stored. Otherwise the current personnel file folder is preselected.

6. Add metadata if desired and click “Save”.

8.6 Pre-Capturing a Document for a Scan

Paper documents can be scanned and assigned automatically to the corresponding personnel
file. The assignment is carried out with a barcode that must be entered in the scan dialog.

To pre-capture a document for a scan, perform the following steps:
1. Navigate in the desired personnel file or personnel file folder.
2. Click the "Pre-Capture” action.

3. Ifyou are at top levelin a personnel file, select the desired personnel file folder in which the
document should be stored. Enter the barcode that resides on the paper document.
Additionally, enter a name for the document.

4. Click "Pre-Capture Document”.

An empty document is created at once. As soon as the document is scanned the content is
taken over in the document. In the personnel file shelf, in the “Scan Queue” field you can find
the documents to be scanned.

Note:

« The "Pre-Capture” action is only available, if it is activated in the personnel file shelf.

« Your system administrator has to configure the scanner software such that the scanned
document is uploaded to Fabasoft Folio via a web service (see chapter 17.4 "Providing
the Scan Functionality”).
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8.7 Uploading a Document

To upload a document, perform the following steps:

1. Navigate in the desired personnel file or personnel file folder.

2. You canimport files using drag and drop, the shortcuts ctrl + candctrl + vorthe
“Upload” action.
Note: Depending on the web browser not all possibilities may be available.

3. Enter a name and select a personnel file folder if applicable. You can also enter further
metadata.

4, Click "Save”.

8.8 Defining the Validity of a Document

Documents that need to be renewed recurrently can be provided with a validity deadline.
To define the validity of a document, perform the following steps:

1. Navigate to the desired document.

2. On the context menu of the document, click “Properties”.

3. Onthe “Document” tab you can enter a date in the Valid from and Valid tofields.

4. Click "Next".

Note: If a document is not yet valid or expired, it is indicated with a red exclamation mark.

8.9 Signing a Document

Documents can be manually signed with signatures like “Approve” or “Release”.
To sign a document, perform the following steps:

1. Navigate to the desired document.
2. On the context menu of the document, click “Tools” > “Manual Signatures”.

3. Enter values in the fields Signature Type, Remark, Signed on/atand Manually Signed by
and click "Add". In the Manual Signatures field all previous signatures and the currently
added signature are shown.

You can repeat this step to sign the document with further signatures.

4. Click "Next” to apply the signatures.

Note: The signatures can also be viewed in the metadata of the document (“Signatures” tab).
The tab is only visible, if at least one signature exists.

8.10 Classifying and Registering a Document

When a Mindbreeze InSpire service is available for automatic classification, metadata is
extracted from the document (if possible) and the registration form is prefilled with this data.

The classification and registration of a document that has not yet been classified and
registered can be done either by means of the “Classifying and Registering” context menu
command or by placing it directly in a personal file or personnel file folder.
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Note: The functionality is only available, if the Mindbreeze InSpire Service is configured
correspondingly.

To classify and register a document, perform the following steps:

1. Navigate to the desired document.

2. Onthe context menu of the document, click “Classify and Register”.
Note: The command is not available if the document is already classified. The category
assigned to the document can also cause that the command is not present. Alternatively,
you can directly copy the document in the desired personnel file folder.

3. |If possible, metadata retrieved from the document is prefilled and highlighted in color.

4. Check and, if necessary, add metadata and click “Save”.

8.11 Registering a Document

Documents that are not registered to a personnel file can be registered using the “Reqgister as
Personnel File Document” context menu command. Alternatively, a document can also be
directly copied in a personnel file or personnel file folder.

To register a document, perform the following steps:

1. Navigate to the desired document.

2. On the context menu of the document, click “Register as Personnel File Document”.
Note: The command is not available if the document is already reqgistered. The category
assigned to the document can also cause that the command is not present. Alternatively,
you can directly copy the document in the desired personnel file or personnel file folder.

3. Select the personnel file and personnel file folder the document should be registered to.

4, Add metadata if desired and click “Save”.

8.12 Re-registering a Document

Documents that are registered to a wrong personnel file or personnel file folder can be re-
registered.

To re-register a document, perform the following steps:

1. Navigate to the desired document.
2. Onthe context menu of the document, click “Re-register”.
3. Select the personnel file and personnel file folder the document should be registered to.

4. Add metadata if desired and click “Save”.

The document is removed from the current personnel file folder and stored in the new
personnel file folder.

8.13 Canceling a Document

A document of a personnel file cannot be deleted directly, but must first be canceled.

To cancel a document, perform the following steps:
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1. Navigate to the desired document.
2. On the context menu of the document, click “Cancel Document”.

3. Click “Yes" to confirm the cancelation.
Note:

e Canceld documents can be found in a personnel file ( “Properties” context menu
command) on the ,Canceled Documents” tab. The tab is only visible if at least one
document or personnel file folder is canceled.

« Canceled documents can be putinto the wastebasket by users who have at least change
rights. Users with full control can permanently delete the documents, if no retention rules
are violated.

8.14 Replacing a Document

A document with state “In Progress” or “Closed” can be replaced with another document. The
replacing document may have a different format (e.g. a Word document can be replaced with
a PDF document).

To replace a document, perform the following steps:

1. Navigate to the desired document.

2. On the context menu of the document, click “Replace” > “Upload”.
Note: Alternatively, you can click “Replace” > “Scan”.

3. Choose a file the document should be replaced with and confirm uploading the file by
clicking ,Yes".

4. Add metadata if desired and click “Replace”.

8.15 Registering Documents Automatically

Documents that are already in the system can be registered to personnel files using a CSV file.
This method is useful if many documents should be reqgistered.

To register documents automatically to personnel files, perform the following steps:

1. Importall documents in a Teamroom. The names of the documents have to be unique.
2. Navigate in the personnel file dashboard or in the desired personnel file shelf.

3. Click the “Register Documents” action.
4

Optionally, click the “Download CSV Template” to retrieve a template that describes the
necessary data structure.

5. Enter the path to the CSV file in the ContentField.
6. Click “Start Import”.
7. After the import has finished click “Next".

The documents are stored in the corresponding personnel file folders.

Available CSV columns:
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CSV Column Field Possible Value

PersNum Personnel number of the String
personnel file

FileShelfId Personnel File Shelf Fabasphere ID or Import ID (has to
be specified if the import is
carried out not in context of a
personnel file shelf)

Folder Import ID of the folder that  String
should be used to store the
document
Teamroom Fabasphere ID of the Fabasphere ID of a Teamroom

Teamroom that contains
the source documents

Document Import ID or name of the String
document that should be
assigned to the personnel
file

DocumentName Name of the document String
(optional, if the name
should be changed)

Category Import ID of the category  String
that should be assigned to
the document

ValidFrom Valid from of the document Date

ValidTo Valid to of the document Date

State Processing State of the String (StateInProgress,
document StateClosed)

Note: The Fabasphere ID can be found on the “General” tab of the corresponding object. The
import ID can be used to update objects and assign these objects to other objects.

If a user-defined form is assigned to documents, these properties can also be imported (the
programming name of the respective property serves as the column caption).

8.16 Predefining Metadata With PDF Documents

When uploading PDF documents, the keywords of the document can be used to predefine
metadata.
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Format: FSC:persnum; fileshelfid; folder;category;validfrom;validto;state;
Example:

o All metadata are predefined:
FSC:00002;C00.1.506.2.2177;PF _FOLDER SALARY;PF CAT ZE;2013-05-23;2015-07-
25;PersonnelFileDocumentInProgress;

o Categoryand Valid to are not predefined:
FSC:00002;C00.1.506.2.2177; PF_FOLDER SALARY;;2013-05-
23;;PersonnelFileDocumentInProgress;

9 Business Case Shelf

In a business case shelf, business cases and documents are managed, which are not assigned
to a single personnel file. Bulk documents can be used to generate and store individual
documents for each personnel file.

The access rights of a business case shelf can be defined using the “Permissions” action. Shelf
folders are available for the hierarchical structuring of a business case shelf.

9.1 Bulk Document

A bulk document can contain several documents (also of different types). One document in the
bulk document can be defined as the main document. In addition, personnel files can be
specified for which personalized personnel file documents can be generated from the bulk
document.

Create and Register Personnel File Documents
To use the bulk document functionality, follow these steps:

1. Navigate to the desired business case and create a bulk document.
Note: It is possible to use a template to create a bulk document. You can also use a
template that has been restricted to files from “Personnel File” - for example, a restricted
Word template with fields from the Personnel File. To read more about the definition of
templates, visit “Defining Templates”.

2. Specify the documents in the bulk document (one as the main document).
Note: In Microsoft Word documents, you can insert fields that allow the document to be
personalized for the relevant personnel file.

3. Define the personnel files (either individual personnel files or an entire shelf) for which a
personnel file document should be generated from the bulk document. The Excluded
Personnel Files fField allows excluding a subset of personnel files.

4. The personalized personnel file documents are created using the “Bulk Document” >
“Create Personnel File Documents” context menu command. The generated personnel file
documents can be found in the properties of the bulk document on the “Personnel File
Documents” tab.

5. Viathe "Bulk Document” > “Reqgister Personnel File Documents” context menu command,
the generated personnel file documents are reqgistered for the corresponding personnel
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files. You must specify the personnel file folder in which the personnel file documents are to
be stored. You can also specify additional metadata.

Print Personnel File Documents

If you want to print the documents to obtain a manual signature, perform the following steps
as well.

1. When carrying out the “Bulk Document” > “Print Personnel File Documents” context menu
command, a single PDF document is generated from all personnel file documents with an
individual QR code for each personnel file document.

2. Print the PDF document and obtain the signatures.

3. Scan the paper documents with the signatures and place them in an appropriately
configured inbox.
Note: More information about inboxes can be found in chapter 17.6 “Inbox".

4. The action defined in the inbox is used to replace all documents in the corresponding
personnel file dJocument with the scanned document. The QR code is used to identify the
personnel file document.

Start Process for Personnel File Documents

To start a process for personnel file documents, proceed as follows:

1. Execute the “Bulk Document" > “Start Process for Personnel File Documents” context menu
command.

2. Select the personnel file documents for which a process is to be started. You can use the
“Remove” context menu command to remove individual personnel file documents.

3. Click "Next".

4. Define the process and click the “Start Process” button.

Remove Canceled and Deleted Personnel File Documents

If personnel file documents have been canceled or deleted, these can be removed from the
bulk document using the “Bulk Document” > “Remove Canceled and Deleted Personnel File
Documents” context menu command. New personnel file documents can then again be
created for the removed personnel file documents.

10 Personnel File Collection

A Personnel File Collection can be created in a Teamroom and can be used to collect
personnel files that are relevant for you. Fill the personnel files collection by adding shortcuts
to the desired personnel files.

11 Personnel File Access

Employees or supervisors can be given access to personnel files. The access can be defined
either permanently or temporarily.
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The documents that employees or supervisors are allowed to view are determined by the
assigned access rights.

11.1 Grant Access

The access can be granted the following way:

Permanent Access (Manually Managed in the Personnel File)

If it is configured that permanent access is manually managed in the personnel file, personnel
file users can store the relevant employees or supervisors on the “Access” tab in the personnel
file:

o Assigned User
In this field, you can enter the employee to whom the personnel file is assigned. This
allows viewing the documents intended for employees.

e Direct Supervisor
In this field, you can specify the direct supervisor. This allows viewing the documents
intended for supervisors.

e Supervisors
In this field, you can specify all higher-level supervisors in the hierarchy. This allows
viewing the documents intended for supervisors.

Permanent Access (Taken Over From the Organizational Structure)

If it is configured that permanent access is taken over from the organizational structure, the
employees and/or supervisors are automatically entered in the “Access” tab of the personnel
file.

Permanent Access (Via Assignments)

Via assignments such as companies or personnel areas, employees can also be granted rights
to personnel files independently of the aforementioned settings in the configuration. To do this,
personnel file users can select assignments in the personnel file on the “Assignments” tab.
Employees then receive read or change rights to the personnel file via the rights defined in the
selected assignment.

Temporary Access

Personnel file users can grant access to personnel files to employees for a limited time. To do
so, navigate to the desired personnel file and execute the “Advanced” > “Grant Temporary
Access” context menu command.

Following fields are available:

e Permissions
Defines the permissions for temporary access.
Note: The selectable permissions are defined in the personnel file configuration.

*  Grant Access for
Access is granted to the specified users.
Note: The users defined in the permissions are preselected.
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o Start
Start date for temporary access.

e End
End date for temporary access.

e Enter Remark
The entered remark will be displayed in the remarks of the personnel file.

o AdJd Attachments
The added attachments will be displayed in the remarks of the personnel file.

In the properties of the personnel file, on the “Access” tab, in the Temporary Access field the
granted accesses are listed. You can also remove entries by selecting the desired rows and
executing the “Remove” context menu command.

Note: Temporary access can also be granted via the “Grant Temporary Access” workflow
activity.

11.2 Restrict Access

For employees or supervisors with access, all documents of the personnel files are readable by
default. By means of categories, for which special ACLs are defined, it is possible to control
which documents are not viewable or which documents should be editable.

Further information can be found in chapter 15.3 “Personnel File Access”.

11.3 Confirm Changes in the Organizational Structure

In general, the organization is not managed by personnel file users. If it is configured that the
permanent access is taken over from the organizational structure, changes regarding the
access of personnel files must therefore be confirmed by personnel file users. These personnel
file users are defined in the personal file configuration or personal file shelf.

You can use the workflow activities “Review Access for Employee” or “Review Access for
Supervisors" to accept the changes.

11.4 Use Cases for Users With Personnel Files Access

As an employee, the personnel files access provides you access to certain metadata and
selected documents in your personnel file (for example, payslips). As a supervisor, you can
view the personnel files of your employees. The following chapters explain how to use the
personnel files access.

11.4.1 Using the Fabasoft Personnel File

All you need to be able to use the Fabasoft Personnel File is a web browser. However, it is
recommended to install the Fabasphere Client to improve the ease of use. Please ask your
administrator for the access data.

Fabasoft Fabasoft Talents 36



11.4.2 Dashboard

If you have been authorized for personal files access, the “Personnel Files Access” dashboard
is available on “Home". The dashboard is intended for employees and supervisors with
personnel files access and is divided into the following areas:

e My Master Data
Shows the master data of your own personnel file.

o My Personnel File
Shows your own personnel file.

o Uploaded Documents
Shows the documents uploaded by the employee (at least one document must be
uploaded).

o Personnel Files With Access
Shows the personnel files of your employees, if you have been granted permanent access.

Note: You can update the list of personnel files using the “Refresh” action, since it is updated
only once a day.

11.4.3 Viewing Metadata

To view the metadata of a personnel file, perform the following steps:
Click the “Personnel Files Access” dashboard.

Click “Personnel Files With Access”.

Click the “Refresh” action, if the desired personnel file is not displayed.
Click the desired personnel file.

Click the “Properties” action.

o a &~ o

Click the desired tab to display the corresponding metadata.
Note: Sensitive metadata such as the social security number, gross income or
denomination are not displayed to supervisors.

7. Click "Next".

11.4.4 Viewing Documents

To view the documents of a personnel file that are available to you, perform the following
steps:

1. Clickthe "Personnel Files Access” dashboard.

2. Click "Personnel Files With Access”.

3. Click the "Refresh” action, if the desired personnel file is not displayed.

4

Click the desired personnel file.
The available documents are displayed in a list.

o

Click the desired document to view the preview of the document.

6. You can use the “Read” action to open the document in the corresponding third-party
product.
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11.4.5 Uploading Documents

The “Upload” action allows you to upload documents that can subsequently be registered by a
personnel file user.

Note: The “Upload” action is only available if this functionality has been enabled in the
configuration or shelf (Members/Employees Can Upload Documents option).

11.4.6 Using Follow-Ups

You can define follow-ups for personnel files or documents. When the follow-up date is
reached, an e-mail with a link to the personnel file or document is sent to you. You can use this
function, for example, if you want to check a document again in three months.

To define a follow-up, perform the following steps:

1. Navigate in the desired personnel file or document.
2. Click the "Manage Follow-ups” or “Create resubmission” action.

3. Click the “Create Follow-up” button, if you have previously used the “Manage Follow-ups”
action.

4. Define the Date of the follow-up.
Note: The Time Span field allows you to conveniently select the date for common time
spans.

5. You can also enter a Message that should be included in the follow-up e-mail.

6. Click “Next".

11.4.7 Using the Worklist

The personnel file provides the possibility to perform activities within a workflow. For example,
an activity could be that your payslip has been stored in the personnel file. You can confirm the
receipt and complete the activity by executing the “Noted” work step.

The worklist that is stored as standard on “Home”, takes you to your activities. The worklist is
divided into the following areas:

« ToDo
Contains activities that you still have to process. An activity can consist of one or more
work steps. A mandatory work step (shown in bold) must be carried out before the activity
can be completed. Click on the desired step to perform it.

* Last Finished
Contains the activities you have completed.

e Concerned Objects
Contains objects that are assigned to current activities.

e Tracking
Contains objects that are assigned to completed activities.
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12 Skills Management

Skills management allows you to manage job and role descriptions and the assignment of
required qualifications. Acquired qualifications and role descriptions can be assigned to
personnel files. Via the organizational structure personnel files are linked to positions. Job
descriptions are assigned to positions.

The lack of qualifications can be determined from the qualifications required and the
qualifications acquired. In addition position reviews can be performed.

12.1 Dashboard

For skills manager, the skills management dashboard is available, which is divided into the
following areas:

e _Job Descriptions
Shows the job descriptions for the organization.

o Role Descriptions
Shows the role descriptions for the organization.

e Qualifications
Shows the qualifications that can be assigned as required qualifications to job and role
descriptions as well as positions. The qualifications can also be assigned to personnel
files as acquired qualifications.

e Position Reviews
Shows review procedures of job descriptions, tasks, powers and qualifications for the
positions by supervisors.

»  Organizational Structure
Shows the organizational structure for the organization.

»  Personnel File Shelves
Shows the personnel file shelves that are used to manage the personnel files.

12.2 Importing Data

If you are in the Skills Management dashboard, you can use the “Import Data” action to import
or update descriptions and qualifications using a CSV file. The "Download CSV Template"
button gives you a template that describes the required data structure.

The CSV columns are generally free-text fields of the character string type. You can use the
import ID to update objects. The following CSV columns are available:

CSV Column Field Possible Value
1d Import ID String
Class - String (object class;

Qualification, JobDescription,

RoleDescription)
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Name Name String

Description Description String

RatingScale Rating Scale String (import ID of the rating
scale; only for qualifications)

TasksPermissions Tasks and Powers String (only for job and role
descriptions)
ReqQualification Qualification (Required String (import ID of the
Qualifications) qualification; only for job and

role descriptions)

ReqQualificationlevel |evel (Required Qualifications)  String (import ID of the rating
scale value of the qualification;
only for job and role
descriptions)

To populate fields that can consist of several rows (e.qg. Required Qualifications), it is possible
to specify several rows in the CSV file with the same 14.

12.3 Managing Qualifications

Navigate as a skills manager in the skills management dashboard in the qualifications widget.

Edit Rating Scales

Rating scales are used to quantify qualifications (for example, failed/passed). You can use the
“Edit Rating Scales” action to change, add or delete the predefined rating scales.

The values of a rating scale consist of a name and a percentage of fulfillment (e.q. Failed 0 %,
Passed 100 %).

Define Qualification Categories

A qualification category defines individual qualifications within an area of competence. You
can use this function as demonstrated in the following examples:

» Add qualifications such as “English”, “German”, and “Italian” to the qualification category
“Language Skills” to combine the languages that are relevant to your company.

» Add qualifications such as “Java”, “MySQL" and “English” to the qualification category
“Junior Developer” to combine the skills that are relevant for this specific position.

When selecting qualifications for job descriptions, role descriptions, and organizational
structures, the qualification categories can be selected from a tree view. In the tree view,
qualifications without a category are available via the tree item “Uncategorized
Qualifications”.
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Create Qualifications

You can use the “Create Qualification” action to define qualifications that can be assigned to
job and role descriptions and positions.

The following fields are available:

e Name
The name of the qualification.

e Description
A more detailed description of the qualification.

e Rating Scale
Defines the appropriate rating scale for the qualification.

e ImportID
If qualifications are managed externally, a unique ID for the import identification can be
defined.

12.4 Managing Job Descriptions

A job description is used to determine the tasks and powers of an employee. In addition, the
qualifications required for the position are defined.

As a skills manager navigate in the skills management dashboard in the job descriptions

widget.

Create Job Description
You can use the “Create Job Description” action to define a job description.
The following fields are available:

e Name
The name of the job description.

e Description
A more detailed description of the job description.

« Tasks and Powers
Defines the tasks and powers of an employee with this position.

e Required Qualifications
Defines the necessary qualifications for the position. For the qualifications it can be
determined which degree of fulfillment is at least necessary.

e ImportID
If job descriptions are managed externally, a unique ID for the import identification can
be defined.

12.5 Managing Role Descriptions

A roles description is used to determine the tasks and powers an employee has independent of
the position (e.q. first responder). In addition, the qualifications required for the role are
defined.
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As a skills manager navigate in the skills management dashboard in the role descriptions
widget.

Create Role Description
You can use the “Create Role Description” action to define a role description.
The following fields are available:

«  Name
The name of the role description.

e Description
A more detailed description of the role description.

o Tasks and Powers
Defines the tasks and powers of an employee with this role.

o Required Qualifications
Defines the necessary qualifications for the role. For the qualifications it can be
determined which degree of fulfillment is at least necessary.

e Import ID
If role descriptions are managed externally, a unique ID for the import identification can
be defined.

12.6 Managing the Organizational Structure

The organizational structure (organizational units and positions) can be managed by
organization administrators or by organizational members who have been authorized by the
“Manage Organizational Structure” policy. This concerns, for example, the assignment of users
to positions. More information can be found in the “Administration Help Fabasphere Al Core” in
the “Manage the Organizational Structure” chapter.

Note: Personnel file-specific properties of an organizational position, such as the personnel
file, can only be managed in the personnel file, but not in the organization's member
administration.

Access

The access for employees or supervisors can be taken over from the organizational structure.
This can be defined in the Permanent Access for Employees or Permanent Access for
Supervisors fields. The corresponding fields in the personnel file are displayed read-only.

In addition, a user or a team has to be defined, which should receive activities concerning
relevant changes for the personnel file. This is necessary because the organization can be
managed by users who do not have permissions in the personnel files. Via the “Review Access
for Employee” and “Review Access for Supervisors” activities the changes can be accepted.

12.6.1 Import Organizational Structures

In addition to the basic properties of an organizational position, other properties of the
personnel file can also be imported in the personnel file and in skills management. This is
possible either via the ‘Import Organizational Structure’ menu in the personnel file or by
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importing via an inbox folder. There are the import definitions “Import Organizational Structure
(Fabasphere Organization)”, “Import Organizational Structure (Fabasphere Organization,
Personnel File)” and “Import Organizational Structure (Fabasphere Organization, Personnel
File, Skills Management)” for the inbox folder.

Note: More information can be found in the “Administration Help Fabasphere Al Core” in the
“Manage the Organizational Structure” chapter.

In addition to the CSV columns of the organizational structure from the Fabasphere
Organization, there are also the following:

CSV-Spalte Feld Moglicher Wert

PersNum Personnel File String (Personnel Number of the
Personnel File)

FullTimeEquivalent Full-Time Equivalent of the Number

Position (in Percent)

Company Company String (import ID of the
company)

Location Location String (import ID of the location)

JobDescription Job Descriptions String (import ID of the job
description)

OptQualification Qualifications Required on the  String (import ID of the

OptQualificationLevel

Basis of the Job Descriptions
(Qualification)

Qualifications Required on the
Basis of the Job Descriptions

qualification)

String (import ID of the required
level)

(Required Level)

12.7 Defining Assignments

Once the qualifications, job descriptions, role descriptions and the organizational structure
have been defined, the individual elements can be put in relationship to each other.

Assign a Personnel File to a Position

As a personnel file user, you are entitled to assign personnel files to positions. To do this,
navigate to the organizational structure in your personnel file dashboard. In the properties of
the desired position you can assign the appropriate personnel file in the Personnel File field. In
addition, you can edit the fields Full-Time Equivalent of the Position (In Percent), Company and
Location.
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Assign Job Descriptions to a Position

As a skills manager, you are entitled to assign the job descriptions and the additionally
required qualifications to positions. To do this, navigate to the organizational structure in your
skills management dashboard or personnel file dashboard. In the properties of the position you
can enter job descriptions and additional qualifications in the appropriate fields.

Assign Acquired Qualifications and Role Descriptions to a Personnel File
As skills manager you are entitled to enter the acquired qualifications in personnel files.

Navigate in your skills management dashboard in the organizational structure. Open the
properties of the corresponding position. On the “Position” tab, in the Personnel File field, the
personnel file is stored. Open the properties of the personnel file. On the “Qualifications” tab,
you can define the qualifications acquired.

12.8 Showing Missing Qualifications

After the assignments have been carried out, the missing qualifications for the individual
employees can be determined based on the difference between the actual qualifications
(defined in the personnel files) and the target qualifications (defined in the positions).

To do this, navigate as a skills manager in your skills management dashboard and click the
“Show Missing Qualifications” action. If you are in an organizational unit, only positions are
considered that are directly or indirectly subordinate. An overview of the missing
qualifications is displayed and it can be exported as a CSV file.

12.9 Position Reviews

Job descriptions must be regularly reviewed by the skills managers, in co-operation with the
supervisor, with regard to the defined tasks, powers and qualifications.

Skills Manager: Start the Position Review
As a skills manager navigate in your skills management dashboard in the position reviews.

The “Start Position Review” action allows initiating the position review by the head of an
organizational unit for subordinate positions. In the “Positions” field, you can view all the
positions for which a review process will be initiated once you click “Start”. If you do not wish
to start a review for all the listed positions, just put a tick on the left of only those positions that
need to be reviewed and then click “Start”.

You have the option of defining a date for the completion and whether the subordinate
organizational units should also be considered. The heads of the organizational units are by
default the review process recipients, i.e. they receive the corresponding activities in their
worklist. However, you are allowed to change the process recipient if you wish. Just expand the
drop-down list and choose the desired user.

Head: “Review Job Description” Activity

The heads of the organizational units receive the “Review Job Description” activity for each
assigned position. The “Review” working step allows you to view the current descriptions. In
case that reworking is required, select in the Reworkfield the “Necessary” entry and enter
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remarks. With the “Done” working step, you end the review. In addition, the steps “Define
Acquired Qualifications” and “Request Further Training” are available. When you request
further training, a process is started and the person responsible for further trainings defined in
personnel file configuration receives an activity.

Note: As skills manager, you can also request further training in the properties of a personnel
file on the “Qualifications?2 tab via the “Request Further Training” button.

Skills Manager: Position Reviews

In the skills management dashboard, the position reviews with status are listed under “Position
Reviews".

Status:

e InProgress
Activity is being processed by the head.

* Rework Required
The head has completed the review and wishes a rework.

e Done
The head has completed the review and does not wish a rework.

If a rework is necessary, navigate in the appropriate position review:

« To change the position, execute the context menu command “Properties” on the position.

« Tochange ajob description, execute the context menu command “Properties” on a job
description.

* You can access the role descriptions by executing the context menu command
"Properties" on the personnel file ("Job and Role Description” tab).

After the rework has been completed, you can use the “Close” action to complete the position
review or you can trigger a further check with the “Send to Review"” action.

13 Applicant Management

The applicant management enables an efficient, digital management of job applications.
Applicant files, job advertisements, applications, a talent pool and corresponding workflow
activities are available for this purpose.

13.1 Dashboard

Applicant managers can use the applicant management dashboard, which is divided into the
following areas:

e Current Job Applications
Displays the current job applications of the shelves in which you are authorized.

e Current Applicant Files
Displays newly created applicant files and applicant files for which there is at least one
current application.
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e Talent Pool
Displays the applicant files of the shelves in which you are authorized that have been
added to the talent pool.

o Job Advertisements
Displays the job advertisements of the shelves in which you are authorized.

o Applicant File Shelves
Displays the applicant file shelves in which the applicant files are managed.

Note: The responsible personnel managers have access to their job advertisements and
applications via the “Personnel File Access” dashboard.

13.2 Applicant Management Shelf

An applicant management shelf is based on a personnel file configuration, but can overwrite
the settings made in it if necessary. The applicant file shelf is used to manage applicant files
and define access rights.

Applicant file shelves can only be created by the personnel file administrator.

Areas
The shelf is divided into the following areas:

e Current Job Applications
Displays the current applications of the shelves in which you are authorized.

o Current Applicant Files
Displays newly created applicant files or applicant files for which there is at least one
current application.

« Talent Pool
Displays the applicant files of the shelves in which you are authorized that have been
added to the talent pool.

o Job Advertisements
Displays the job advertisements of the shelves in which you are authorized.

o Closed Applicant Files
Displays the closed applicant files.
Settings
“"Applicant Management Shelf” tab

e Standard Category for Applicant Files in Talent Pool
Applicant files with commitment to the talent pool get the specified category. This way,
for example, the retention period can be defined. The setting in the configuration is
overwritten.

“Default Values” tab

o Default Thesaurus for New Terms
If o default thesaurus is specified, new terms can be created directly during tagging.
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o Default Categories
When an object is created, the specified category is assigned according to the defined
object class. In the Apply tofield, you can specify whether the setting applies to
instances, templates, or both.

o Default Processes
When an object is created, the specified process is assigned according to the defined
object class or category. In the Apply to field, you can specify whether the setting applies
to instances, templates, or both.

o Additional Default Background Tasks
When an object is created, the specified background tasks are assigned.

Note: The default properties overwrite or extend the settings in the configuration.

Access Rights

e Full Control
Users with full control can authorize users, manage job applications, applicant files and
job advertisements and edit shelf settings.

* Applicant Manager
Applicant managers can manage job applications, applicant files and job
advertisements.

13.3 Managing Applicant Files

As an applicant manager, navigate to the current applicant files in the applicant management
dashboard.

The following options are available:

* You can use the “Create Applicant File"” action to create an applicant file. You can enter
master data and contact data.

* You can assign the applicant file to another shelf using the “Advanced” > “Change
Assignment” context menu command.

» You can merge the applicant file with another file using the “Advanced” > “Merge”
context menu command.

« You can assign a new job application to the applicant file using the “Create Job
Application” action.

« Applicant files can only be deleted if no open job application is assigned.

The “Closed Applicant Files” area is available in the applicant file shelf. Here you will find the
applicant files with no open job application.
13.4 Managing Job Advertisements

As an applicant manager, navigate to the job advertisements in the applicant management
dashboard.

The following options are available:
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» You can create a job advertisement using the “Create Job Advertisement” action. You
must specify the responsible personnel manager. If personnel manager is subsequently
changed, the change does not apply to existing job applications based on the job
advertisement.

« You can define the state of the job advertisement (“In Process”, “Published”, “Closed"”) in
the properties of the job advertisement.

« Job advertisements can only be deleted if all assigned job applications have already
been deleted.

13.5 Managing Job Applications

As an applicant manager, navigate to the current applications in the applicant management
dashboard.

The following options are available:

« You can create a job application using the “Create Job Application” action. You must
specify an applicant file, a job advertisement and the responsible personnel manager.

« You can use the “Switch to Applicant File” action to switch to the assigned applicant file.

* You can use the “Grant Temporary Access” action to define access.

13.6 Managing the Talent Pool

The talent pool stores closed applicant files for which the Commitment for Talent Pool option
has been selected. In this way, applicants for whom no job is currently available can be kept
as evident.

13.7 Personnel File Access

The personnel managers have access to the applications and job advertisements that concern
them via the personnel file access dashboard. Employees can also receive read or change
rights to applicant files via assignments.

The following areas are available:

e Current Job Applications
Displays all open applications for the personnel manager (including temporary access
and if contained in the Other Personnel Managers field).

o _Job Advertisements
Displays all job advertisements in which the personnel manager is entered as the
responsible personnel manager.

o Applicant Files With Access
Shows all applicant files to which the employee has access via assignment rights.

13.8 Website Integration

Job applications can also be created automatically using the data entered in an HTML form.
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To do this, the £nable Website Integration option must be enabled on the “Applicant
Management” tab in the personnel file configuration.

You can provide a corresponding HTML form for applications on your homepage.

<!doctype html>
<html lang="en">
<head>
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />
<title>Job Application</title>
</head>
<body>

<form name="createobjectform"
action="https://at.cloud.fabasoft.com/fsc/createobject" method="post" accept-
charset="UTF-8" enctype="multipart/form-data">

<input name="redirect" value="https://www.example.com/result.html"
type="hidden">

<input name="errorredirect" value="https://www.example.com/err.html"
type="hidden">

<input name="objectclass" value="FSCPERSONNELFILE@1.1001l:ApplicantFile"
type="hidden">

<input name="inbox" value="COO.w.x.y.z" type="hidden">

<input name="jobadvertisement" value="COO.w.x.y.z" type="hidden">
<label for="userfirstname">First Name</label>

<input id="userfirstname" name="userfirstname" wvalue="" type="text'">
<br/>

<label for="usersurname">Surname</label>

<input id="usersurname" name="usersurname" value="" type="text">
<br/>

<label for="telephone">Telephone</label>

<input id="telephone" name="telephone" value="" type="text">

<br/>

<label for="emailinformation">E-Mail</label>

<input id="emailinformation" name="emailinformation" value="" type="text">
<br/><br/>

<input id="afusetalentpool" name="afusetalentpool" value="true"
type="checkbox">

<label for="afusetalentpool">Talent Pool</label>
<br/><br/>
<label for="locationl">Location</label><br/>

<input id="locationl" name="location" value="COO.w.x.y.z" type="checkbox">
Linz<br/>

<input id="location2" name="location" value="COO.w.x.y.z" type="checkbox">
Wien<br/>

<input id="location3" name="location" value="COO.w.x.y.z" type="checkbox">
Bern<br/>

<br/>

<input name="attachmentattrdef"
value="FSCPERSONNELFILEQ@1.1001l:afdocuments" type="hidden">

<input name="attachmentkeys" value="attachmentl COO.w.x.y.z,attachment2"
type="hidden">

<label for="attachmentl">Cover Letter</label>
<input id="attachmentl" name="attachmentl COO.w.x.y.z" type="file">
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<br/>
<label for="attachment2">CV</label>
<input id="attachment2" name="attachment2" type="file">
<br/><br/>
<input value="Send" type="submit">
<input type="reset">

</form>

</body>

</html>

In the example above, the Fabasphere IDs must be replaced by your concrete values.

inbox

The Fabasphere ID of the applicant management shelf.

jobadvertisement

The Fabasphere ID of the job advertisement.

location (optional)
The Fabasphere IDs of the locations.

attachment (optional)
If the Fabasphere ID of a category is added with an underscore to the name attribute of a
file, the category will be assigned to the document.

Further information for creating the HTML form can be found here:

https://help.cloud.fabasoft.com/index.php?topic=doc/User-Help-Fabasphere-Al-Core-

eng/advanced-use-cases.htm#form-inbox

13.9 Applicant Management Process

The applicant management process begins with the creation of a job application or the
receipt of an application via an inbox.

A simple process flow of an applicant management process can look like this:

1.

After creating an application, the applicant manager receives the “Check Job Application”
activity and performs the “Forward to Responsible Personnel Manager” working step.

The personnel manager receives the “Edit Job Application” activity and performs the
“Invite applicant” working step. Thereby appointments can be proposed.

The applicant manager receives the “Arrange Appointment” activity and performs the
“Send appointment” working step. The agreed appointment can be communicated via the
“Respond to Personnel Manager” working step.

The personnel manager receives the “Appointment Arranged” activity and performs the
“Take Note” working step. The workflow does not continue until the day of the
appointment.

On the application day, the personnel manager receives the “Conduct Interview” activity
and performs the “Accept” working step.

The applicant manager receives the “Accept Applicant” activity and performs the “Send
Acceptance” and “Done” working step.
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Activities and Working Steps in Detail

* Check Job Application
o Open

o Send Receipt
Opens an e-mail.

o Check Allocation of Applicant File
Must be executed if a possible duplicate is found.

o Edit Applicant File
Enables you to add master data.

o Forward to Responsible Personnel Manager
The personnel manager receives the “Edit Application” activity.

o Discard
Closes the job application.

o Withdrawn
Closes the job application.

o Reject Without Forwarding to Personnel Manager
The applicant manager receives the “Reject Applicant” activity.

« Edit Job Application
o Open

o Forward Application
The applicant manager receives the “Forward Application” activity.

o Need Further Information
The applicant manager receives the “Need Further Information” activity.

o Invite Applicant
The applicant manager receives the “Arrange Appointment” activity.

o Withdrawn
The applicant manager receives the “Application Withdrawn” activity.

o Reject
The applicant manager receives the “Reject Applicant” activity.

e Forward Job Application
o Open

o Send E-Mail to Applicant
If necessary, the applicant may be asked whether the data may be forwarded to
another personnel manager.

o Forward to Personnel Manager
Another personnel manager can be selected.

o Withdrawn
Closes the job application.

¢« Need Further Information

o Open
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o Send E-Mail to Applicant
Further information may be obtained from the applicant.

o Received Information
The information can be forwarded and the personnel manager receives the "Edit
Application” activity.

o Withdrawn
The personnel manager receives the “Application Withdrawn" activity.

* Reject Applicant
o Open

o Send Rejection to Applicant
The applicant manager can send a rejection e-mail.

o Done
Closes the job application.

o Forward to Personnel Manager
The job application can be forwarded to another personnel manager.

o Withdrawn
Closes the job application.

* Arrange Appointment
o Open

o Send Appointment
The applicant manager can send an appointment to the applicant by e-mail based on
the proposals made by the personnel manager.

o Respond to Personnel Manager
IF an appointment has been agreed, the personnel manager receives the “Appointment
Arranged” activity. If no appointment has been made, the personnel manager receives
the “Edit Application” activity.

o Withdrawn
The personnel manager receives the “Application Withdrawn” activity.

* Appointment Arranged
o Open

o Taken Note
The personnel manager takes note of the agreed date. The workflow continues on the
day of the appointment.

o Withdrawn
The applicant manager receives the “Application Withdrawn” activity.

o Reject
The applicant manager receives the “Reject Applicant” activity.

« Conduct Interview
o Open

o Another Interview Needed
The applicant manager receives the “Arrange Appointment” activity.
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o Withdrawn
The applicant manager receives the “Application Withdrawn” activity.

o Accept
The applicant manager receives the “Accept Applicant” activity.

o Reject
The applicant manager receives the “Reject Applicant” activity.

* Accept Applicant
o Open

o Send Acceptance
The applicant manager can send an acceptance e-mail.

o Forward Acceptance
The applicant manager can inform other users of the acceptance. These users receive
the "Accepted Applicant" activity.

o Done
Closes the job application.

o Withdrawn
The personnel manager receives the “Application Withdrawn” activity.

e Accepted Applicant
o Open

o Transfer Documents to Personnel File
Users who are allowed to manage personnel files can transfer the applicant file to a
personnel file (new or existing).

o Take Note
Closes the job application.

o Application Withdrawn
o Open

o Take Note
Closes the job application.

14 Workflow

Tasks to be performed can also be managed using the workflow. For general information on
the workflow, see the Fabasphere Al Core User Help (chapter “Workflow").

An ad hoc process allows you to define the process flow by yourself. Consequently, you can
react flexibly to situations for which no predefined processes are available. Recurring
processes can be efficiently represented with predefined BPMN processes.

In particular, you can use the following activities to perform the tasks in the personnel file
context:

Bulk Documents

e Edit Bulk Document
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e Create Personnel File Documents
e  Print Personnel File Documents

» Register Personnel File Documents
General

» CloseFile
e Close Document
* Replace Document
e Print Document
e Reqister
Note: In order to be able to use the Assigned User, Supervisors and Direct Supervisor properties

in processes which are applicable for documents, the Object with Personnel File Aspect aspect
must be defined in the applicability of the process.

15 Security Concept

The management of access rights is based on the defined team of the personnel file shelf.
Additionally, categories can be used to assign fine-grained access rights to personnel files,
personnel file folders and documents.

Finally, the security concept allows defining retention rules and access by employees and
supervisors.

Note: ACL is the abbreviation for “Access Control List” and defines the access rights from a
technical point of view.

15.1 Define Permissions (Personnel File Shelf)

By default only team members have access rights.

«  Full Control
Users with full control can change the settings of the personnel file shelf and delete
personnel files and documents permanently (if no retention rules are violated).

« Change Access
Users with change access can manage personnel files and documents.

« Change Access (Master Data)
Users with change rights to master data can only manage master data of a personnel file.
Furthermore, they can import personnel files, but the creation or deletion of personnel files
is not possible.

* Read Access (Master Data)
In addition to the read access all master data (except sensitive master data like
birthplace, social security number, nationality, denomination, gross income, bank account
and comments) is readable.

+ Read Access (Restricted Master Data)
Users with read access and restricted master data access can only read a few metadata
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of a personnel file. They can also navigate to personnel file folders and documents that
are specified by a category. To do so users/organizations can be defined in a category on
the "Permissions” tab in the Change Access for Objects with this Category or Read Access
for Objects with this Category field.

This way it can be realized, for example, that the IT department can save, cancel or
restore order confirmations without having access to the remaining data of the personnel
file.

o Skills Manager
Skills manager manage qualifications, job and role descriptions and can generate
overviews of missing qualifications of employees.
They have access to all master data (except sensitive master data like birthplace, social
security number, nationality, denomination, gross income, bank account and comments).
Skill masters have no access to the documents of the personnel file, unless they have been
authorized by a category.

Note: Access rights can also be defined by defining access for employees and supervisors.

15.2 Category

Cateqgories of personnel files, personnel file folders and documents can define access rights,
retention rules and automatic follow-ups.

15.2.1 Permissions

On the “"Permissions” tab following fields are provided:

o Default ACL for Objects with this Category
If an access by employees and supervisors is defined, documents can be excluded
(without access) or change rights can be granted.

o Change Access for Objects with this Category
Users who have not been defined as team members get change access on objects with
this cateqgory.

e Read Access for Objects with this Category
Users who have not been defined as team members get read access on objects with this
category.

15.2.2 Retention Worthy

Retention worthy documents cannot be deleted as long as the personnel file is “Active”. The
retention worthiness can be defined by the assigned category. To do so, in the category, on the
“Retention” tab, the Retention Worthy field must be marked.

15.2.3 Retention Periods

Retention periods prevent the deletion of personnel files or documents until the time limit
expires. Retention periods cannot be backdated.

Retention periods are, for example, used to prevent the deletion of documents for a certain
period of time after an employee leaves the company.
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Categories Define the Retention Rules

In the category of personnel files or documents a retention rule is defined (example: retention
period of 30 years after an employee leaves the company).

To do so, in the category, on the “Retention” tab the Retention Worthy field must be marked.
The Retention Period and Base Date for the Beginning of the Retention Period fields the
retention period can be defined.

Apply Rules When Closing a Personnel File (Default Method)

The background task applies the rule defined in the category at a defined point in time
(example: one day after the separation date the rule is applied).

Configure a default category for personnel files in the personnel file configuration or shelf. In
the cateqory, specify a default background task that starts a process that contains the “Close
File” activity. For example, select “1 day” for the time interval, “After” as operator and
“Separation Date (Personnel File)" entry as base date for the time interval. This will start the
close process one day after the separation date. The retention periods are calculated and
applied on closing.

Apply Rules With Background Tasks (Alternative Method)

The background task applies the rule defined in a category at a defined time (for example, the
rule is applied one day after the separation date is reached).

The background tasks can be defined either in the personnel file configuration on the “Default
Values” tab in the Default Background Tasks field or in the personnel file shelf on the “Default
Values” tab in the Addlitional Default Background Tasks field or in the category on the
“Background Tasks” tab.

In the background task, in the Action field the Determine Retention Period Based on the
Category entry must be selected. The execution of the background task is based either on the
Time Interval and the Base Date for Time Interval or is based on a specific Date. The base date
may refer either to a date field of the document or on a date field of the assigned personnel
file.

The background tasks assigned to the individual personnel files or documents can be viewed
on the “Retention” tab in the Background Tasks Field (only visible if at least one background
task is available). The background tasks are taken from the personnel file shelf and from the
assigned category. If default background tasks are changed in the personnel file shelf or
category, they are not adopted automatically. An update can be performed via the context
menu command “Update Background Tasks”.

15.2.4 Disposal

After the retention period documents can be deleted again. To delete documents
automatically or to start a workflow to confirm the deletion, categories and background tasks
can also be used.

To do so, add in the category that defines the retention period, an additional background task.
In general, it makes sense to define the Retention Period as base date for the execution of the
task. As action, you can either select “Delete Automatically”, “Delete Automatically
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(Documents of Closed Personnel Files Are Not Deleted)” or “Start Process”. If you want to start a
process, you must also specify the process. In the process, a task with the activity “Retention
Period Exceeded” should be defined.

When the background task is executed, the process is started and can be processed by the
defined users in the worklist. The “Retention Period Exceeded” activity provides the steps
“Delete”, "Extend Retention Period” and “Accept”.

15.3 Personnel File Access

Accessing a personnel file by the employee himself or by supervisors can be defined on the
“Access” tab of a personnel file.

If certain documents should be inaccessible or changeable, a category can be used to define
special ACLs:

o ACL for Personnel File Documents With Change Access for Employees

o ACL for Personnel File Documents With Change Access for Employees/Supervisors
o ACL for Personnel File Documents With Change Access for Supervisors

o ACL for Personnel File Documents Without Access for Employees

o ACL for Personnel File Documents Without Access for Employees With Change Access for
Supervisors

o ACL for Personnel File Documents Without Access for Employees/Supervisors

o ACL for Personnel File Documents Without Access for Employees/Supervisors With
Change Access for Users Participating in Workflow

o ACL for Personnel File Documents Without Access for Employees With Read Access for
Users Participating in Workflow

o ACL for Personnel File Documents Without Access for Employees With Read Access for
Supervisors/Users Participating in Workflow

o ACL for Personnel File Documents Without Access for Supervisors

15.4 Assignments

Assignments such as companies or personnel areas can be used to manage rights to personnel
files and applicant files. The properties “Read Access for Files with this Assignment” and
“Change Access for Files with this Assignment” can be used to define users, teams or
organizational units in the same way as the authorizations for categories. The assignments
can be selected in the properties of personnel files or applicant files in order to authorize
employees to access specific files only.

16 SAP Integration

The SAP integration enables the following scenarios:

o Linking HR master data in SAP with the respective personnel files

« Storing payslips generated with SAP in the respective personnel files
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o Export of the organizational structure from SAP and import to the Fabasoft Personnel File

16.1 Linking HR Master Data

The SAP integration allows linking HR master data in SAP with the respective personnel file.
The integration is carried out with an own information type 9600 “Fabasoft Personnel File”.

Note: If new personnel files should be created via SAP, a manual assignment of personnel
numbers is required (settings of the personnel file shelf > “Numbering” tab > Generate
Personnel Number Automatically > "No").

16.1.1 Log-invia SAP

For data exchange between the Fabasoft Personnel File and SAP, you must store a password
for applications in SAP. If no or no valid password is stored, the dialog for entering the
credentials is automatically opened when you call a function that requires a connection to the
Fabasoft Personnel File.

16.1.1.1 Defining a Password for Applications in SAP
To store the credentials in SAP, perform the following steps:

1. The password dialog is opened, for example, when you execute the “Create” command on
the information type 9600 “Fabasoft Personnel File” and then click the “Personnel File”
button.

Note: If the data set for the information type 9600 has already been created, execute the
“Change” command instead of “Create”.

2. Inthe Username field enter the e-mail address that you are using for logging in to the
Fabasoft Personnel File. In the Password'field enter your generated password for
applications. More information about generating such a password can be found in chapter
16.1.1.2 “Generating a Password for Applications”.

[= Fabasoft Personnel File

Username §denver.meyer@global.com| _
Password |\I'\I"l’l’\l’\l’\l’\l"l’l’**********************4
(][]

3. Click "OK".

The password is stored in SAP and need not be entered again as long as it is valid.

16.1.1.2 Generating a Password for Applications

To generate a password for applications, perform the following steps:

1. Navigate in your web browser to the Fabasoft Personnel File.

Open the account menu (your user name) and click “Access for Applications”.

2

3. Inthe Passwords for Applications field click “New".
4. Inthe Valid forfield select “Fabasoft Personnel File".
5

Choose a validity period.
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6. Click “Next".

7. Copy the generated password in the clipboard, to be able to store it in SAP. For security
reasons, this password is displayed only once.

8. Click “Close”.

16.1.2 Creating a Data Set for the Information Type 9600

The link of HR master data in SAP to a personal file is carried out via the information type 9600
“Fabasoft Personnel File".

To create a data set for the information type 9600, perform the following steps:
Switch to the SAP GUI.

Run the PA30 transaction.

Switch to the HR master data for which the data set should be created.
Select the information type 9600 “Fabasoft Personnel File”.

Execute the “Create” command, to create the data set.

o o b o oH

The “Personnel File” button can be used to directly create a new personnel file or to link to
an existing one. More information can be found in chapter 16.1.3 “Managing Links to
Personnel Files".

Create Fabasoft Personnel File

LR

el | d " | Personnel Fle |
== ES o ||| || & Personnel No 50000003 Name Meyer Denver
Find by EE group [1] Active Pers.area RTO01 Personnel Area ATO01
- 22 Person EE subgroup ZH | Salaried employees

- () Colective search help Start 01.03.2016| To 31.12.9999

G GE] Search Term

* [ Free search | Fabasoft Personnel File

Personnel File Shelf

|
7. Click the “Save” button to store the data set.

Note: Delete the record for information type 9600 to remove the link to the personnel file.
Deleting the data record has no effect on the personnel file itself.

16.1.3 Managing Links to Personnel Files

The link between the HR master data in SAP and the personnel file is managed via the
“Personnel File” button of the information type 9600.

Create Fabasoft Personnel File

1 |2 ha || Personnel Fie |

The link is based on the personnel number. When creating a link to a personnel file the
corresponding personnel file shelf is automatically stored in the Personnel File Shelffield.
Depending on the use case you can carry out the following using the “Personnel File” button:

« If no personnel file with the personnel number exists, you can decide whether a new
personnel file should be created. If several personnel file shelves exist, you can choose in

Fabasoft Fabaosoft Talents 59



which the personnel file should be created.
Note: Canceled personnel files are considered as existing, delete personnel files
(wastebasket) are considered as not existing.

o If a personnel file shelf is already stored in the information type 9600, the corresponding
personnel file with the associated personnel number is opened.

« If only one personnel file with the associated personnel number exists within all personnel
file shelves, the link will be automatically created. If the personnel number exists in
several personnel file shelves, you can choose one personnel file shelf.

» Ifthe HR master data in SAP differs from the personnel file you can decide whether the
data of the personnel file is replaced by the HR master data in SAP (see also next
chapter).

[ Fabasoft Personnel File

The master data in SAP and the Fabasoft

Personnel File are different.

9 Do you want to update the master data in the

Fabasoft Personnel File now?

E\I Yes 1|x No ]

* Inall use cases the linked personnel file is opened in the web browser, if you allow the
access in the displayed dialog.

« Ifthe personnel file shelf has changed you have to save the data set of the information
type 9600 again. In this case open the data set with the “Change” command instead of
“Display”.

16.1.4 Synchronizing HR Master Data

When opening a personnel file via SAP the following HR master data is matched and, if
desired, overwritten in the personnel file:

“Master Data"” tab
e Surname
e First Nome
o Tittle
e PostTitle
e All Previous Names
« Date of Birth
e Social Security Number
¢« Entry Date
e Separation Date

"Contact Data” tab

« Bank Account
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e Address
o Telephone Numbers
e« E-Mail Addresses

« Language for Communication

16.2 Storing Payslips

SAP-generated payslips can be automatically stored in the respective personnel file.

Transfer Payslips to the Fabasoft Personnel File

% o = [ B © orgStructure ¢ Search Help

Payroll Period -
Period [ current Payroll Period |
Payroll Area ’:‘ | |- |
perod o
Selection Criteria
Personnel Number |—|
Payroll area ’:‘ E’l

Selection options

Form FABA_PRYSLIF AT

Country Grouping

8

Define Login Data

Define Login Data

Options for File Names

Pattern for File Names |PAYSI_IP_&1—&2.pdf
Placeholders for File Mames |YYYY;MM |

To store the payslips in the respective personnel files, perform the following steps:
1. Switch to the SAP GUIL.

2. Runthe SE38 or SA38 transaction and execute the report /FABASOFT/VDN2RECM.
Note: Alternatively, the transaction /FABASOFT/VDN2RECM is also available.

3. Click "Define Login Data”. If you want to run the report interactively, enter your SAP user
name (prefilled), your Fabasoft Personnel File user name (e-mail address) and the
password for applications (see chapter 16.1.1.2 “Generating a Password for Applications”).
Click "OK".

Note: If another SAP user is intended to generate the report (For example, for background
processing), perform this step again to store additional log-in information.

4. Select the required payroll period and selection conditions.

5. Inthe Selection Options, select the HR form for the payslip (must correspond to the HR form
specified in the configuration) and specify the Country Grouping of the HR form (according
to the HR form definition in HRFORMS).

6. Inthe Options for File Names, specify a pattern for file nomes (e.q. Payslip &1-&2.pdf). For
the placeholders «1, &2, etc. used in the pattern, you must define a corresponding number
of placeholder values separated by semicolons in the Placeholders for File Names field.
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The following placeholder values are available: Yyvyy (year of the period, four digits), Yy
(year of the period, two digits), MM (month of the period) and PERNR (personnel number).

7. Click the “Execute” button.

16.3 Export and Import of the Organizational Structure

A CSV file describing the organizational structure can be generated from the organizational
chart and employee master data available in SAP. The organizational structure can be
transferred using the import mechanism of the Fabasoft Personnel File.

Export from SAP

To export the organizational plan, proceed as follows:

1.
2.
3.

Switch to the SAP GUI.
Call transaction SE38 or SA38 and execute program ZHR_EXPORT_ORG.

Specify the following data:

o

Key Date
The organizational structure is generated for the specified key date. If you want to save
a variant that uses the current date, save the field without a value.

Plan Version
Plan version 01 (current plan version) is used by default.

Source Object
Defines the organizational unit that serves as root of the exported organizational
structure.

Directory

The CSV file is stored in the specified directory on the SAP application server.

Note: For further use, for example, an automatic copy task can be set up at operating
system level which copies the stored files to a Teamroom connected via WebDAV as a
network drive.

File Name
Specifies the file name of the CSV file. <paTE> can be used as placeholder for the key
date.

Overwrite
Specifies whether an existing file with the same name should be overwritten.

With Header
Determines whether column headers are generated in the CSV file.
Level with "OUTLevel” Prefix

Determines whether the prefix “OUTLevel” is added to the level of the organizational
unit.

4, Click the "Execute” button.

Note: To keep the organizational structure up to date, you can create a variant with the
required data and execute it in the background.
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Import into the Fabasoft Personnel File

To import or update the organizational structure, perform the following steps:
1. Switch to the Fabasoft Web Client.

2. inthe dashboard of the personnel file or skills management, click Organizational Structure.
3. Click the “"Import Organizational Structure” action.

4. Select the CSV file exported from SAP.

5

Click “Start Import”.

17 Administration Tasks

In the following chapters you find administration tasks for the personnel file.

17.1 Prerequisites

To be able to use the personnel file, it is necessary that the “Personnel File” service package is
activated. In addition, the service packages “Personnel File (Access)” and “Skills Management”
are available as optional extensions. This can be checked in the properties of the organization
(“Solutions” tab > Solutions).

After purchasing the service package the organization owner, organization administrators and
payment user get a notification in the welcome screen that a personnel file configuration must
be created.

You can forward the notification to a responsible person or create a configuration
immediately. After creating a configuration, the corresponding personnel file dashboard is put
on "Home" of the specified personnel file administrators and the notification will be removed
from all receivers.

Note: If a personnel file administrator is removed from the configuration, the personnel file
dashboard is removed from “Home" of the corresponding user.

17.2 Personnel File Configuration

In the personnel file configuration common settings, the structure of personnel files and the
personnel file users are defined. The defined personnel file administrators can edit the
corresponding personnel file configurations.

17.2.1 Dashboard

In the dashboard of the personnel file configuration you can define following settings. If a field
is hidden, you can display it using the “View"” menu.

*  Personnel File Shelves
The personnel file shelf is used to manage the personnel files and to specify the access
rights. More information can be found in chapter 17.3 “Personnel File Shelf”.

o Applicant File Shelves
shows the applicant file shelves that are used to manage the applicant files.
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»  Business Case Shelves
Shows the business case shelves that are used to manage the business cases.

e Folder Structure for New Personnel Files
The defined folder structure is assigned to each newly created personnel file.

o You can define a personnel file folder hierarchy. To do so, navigate in the tree view to a
superordinate personnel file folder, open the context menu in the tree view and click
the “Create Personnel File Folder” command.

o Inthe personnel file folders, you can store standard documents. When creating new
personnel files the personnel file folders and documents are duplicated. The
document’s category will be retained.

o The predefined personnel file folders cannot be removed from a personnel file. If you
need several folders only in special personnel files, define the folders manually in the
corresponding personnel files.

o A modified folder structure only applies to newly created personnel files. But you can
update the folder structure of existing personnel files (see chapter 17.7 “Update
Settings”).

o Inthe Default Categoryfield a category can be defined that is assigned to the
corresponding personnel file folder in the personnel file. Only categories are selectable
that are defined in the Categories field (personnel file configuration).

Note: The category is also propagated to documents in the personnel file folder. If the
categories are restricted in the Available Categories field, the category is only
propagated if it listed as available category.

Categories are used to define access rights, retention rules and follow-ups.

o With the Available Categories field the categories that can be assigned to documents
in a personnel file folder can be restricted. Only categories can be selected that are
allowed in the superordinate hierarchy.

e Forms and Categories
The here defined categories can be assigned to personnel file folders and documents.
Personnel file folders can restrict the defined categories.
Forms can be used to allow employees to create objects based on the forms using the
personnel file access dashboard. For example, employees can create leave requests.

e Processes
Shows the available user-defined processes.

o Templates
In the create dialog (e.g. “New” context menu command in a Teamroom) the templates
are displayed according to the grouping by the template categories.

e Text Modules
The defined text modules can be inserted into Word documents.

o Thesauri
Shows the thesauri in which terms for tagging of documents can be managed. At least
one thesaurus has to be created so that the tagging can be used. The default thesaurus for
new terms is defined in the settings of the personnel file configuration. Thus, new terms
can be created directly in the tagging process. If no standard thesaurus is specified, only

Fabasoft Fabasoft Talents 64



the predefined terms in the thesauri can be used.
Note: Thesauri can also be defined for personnel file shelves.

e Presettings
Shows the defined display settings, search forms, and time intervals.

e Companies
If a corporation consists of several companies, the defined companies can be assigned in
organizational positions and applicant files.

e Locations
The defined locations can be assigned in organizational positions and applicant files.

e Personnel Areas
The personnel areas specified here can be assigned in the personnel files and applicant
files.

Employee Groups
The employee groups specified here can be assigned in the personnel files and applicant
files.

»  Organizational Keys
The organizational keys specified here can be assigned in the personnel files and
applicant files.

e Reports and OData Services
Allows the definition of report templates (see section 17.2.2 ) as well as of OData Services.

o Failed Background Tasks
Shows failed background tasks (only visible, if at least one failed background task is
available). You can perform following manual actions: “Define Next Execution”, “Send
Link” and “Delete”.

Note: You can define more settings with the “Settings” action (see chapter 17.2.9 “Settings”).
The “Personnel Areas”, “Employee Groups” and “Organization Key” lists must first be activated
via the “Assignments” tab in the personnel file configuration.

17.2.2 Create Report Templates/Reports

To create a report in Personnel File, you need to define a report template First. Report
templates can be defined in the Personnel File configuration as well as in Templates and
Presettings within a Personnel File shelf. For the definition of a report template, you need to
specify the scope within which the template will be used. The available scopes are:

» Applicant File Shelf (App: Applicant Management)

»  Applicant Management Dashboard (App: Applicant Management)
» Personnel File Shelf (App: Digital Personnel File)

o Personnel File Dashboard (App: Digital Personnel File)

o Skills Management Dashboard (App: Skills Management)

Once a report template is created, an action for generating the corresponding report is added
to the menu of the specified scope. When the action is executed, it is applied to the objects of
the specified scope and a report is accordingly generated. All generated reports are listed in
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the “Report Results” widget, which becomes available in the corresponding scope once the
first report is created.

So long as a report creation action is available in the menu, you can execute it multiple times if
you want to generate multiple report instances (which will appear in “Report Results”) to
compare for example current with past data. If you no longer need the action, navigate to the
configuration and then into the “Reports and OData Services” widget. Right-click the report
template you no longer need and select “Delete”.

The following report types are supported in Personnel File:

e Microsoft Excel reports

* BIRT reports

17.2.2.1 Creating an Excel Report

To create an Excel report, perform the following steps:

1. Navigate to the Personnel File configuration.

2. Click the "Reports and OData Services” widget.

3. Click “Create Report Template” in the left menu.

4. From the dialog that pops up, select “Microsoft Excel Report”.
5

Fill in the provided fields to specify the attributes of the generated report and then click
“Next”. The provided fields are as follows:

o Multilingual Name
Defines the name of the report. You can define a report name in multipole languages.

o ReportLanguage
Defines the language of the report content (e.q. the column headers). Note that if you
select a report language, e.g. English, the action that generates the report will only be
available to users with the same Ul language setting, i.e. the English Ul in this example.
IF you want this action to be visible in every Ul just leave the field empty.

o Report Locale
Defines the locale of the report which determines for example the date format etc.

o Format of the Report
Defines whether the report will be a Microsoft Excel Worksheet or a CSV file.

o Scope of Analysis
Defines for which objects the action for generating the report will be available. If for
example, the scope of analysis is the Personnel File shelf, the action will be offered only
within each shelf and the generated reoort within a shelf will include objects of this
shelf only. In contrast if you wish to create a report that will contain all objects in
Personnel File, the Personnel File dashboard should be selected instead. In this case,
the action for generating the report will appear in the Personnel File dashboard.
Note: If you select the personnel file shelf as the scope of analysis, the action will be
available within every shelf. If you want the action to appear only within a specific
shelf, navigate into this shelf, go to " Templates and Presettings” and Click the “Reports
and OData Services” widget. Then the procedure proceeds in the same way.
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o Content of the Report
Defines what will be displayed in the report. The offered report content types vary
based on the selected scope of analysis.

o Include Release Versions Only
Excludes draft versions of objects.

o Exceptions for Release Versions
Appears once the "/nclude Release Versions Only" option is activated. You can enter
object types in this field (or an asterisk (*) to search) which are to be included in the
report even if they are in a draft state.

o Include Valid Objects Only
Includes objects in the search that are currently valid. Note that object validity can be
restricted through the properties “Valid From” and “Valid Until".

o Filter Values
Indicates that the result values of the report will be filtered.

o Expression for Filtering Values
Appears once the “Filter Values” option is activated. It defines an app.ducx expression
that Ffilters the result values, which will be included in the report.

o Restrict Report Creation to
Restricts the ability to generate the report to specific members.
Note: If you want to define a restriction, it is recommended that you add yourself to the
list temporarily in order to test and adjust the report after creating it. Remove yourself
from the field ofterwards.

o ReportColumns
It appears once the report content has been specified (see the “Content of the Report”
field above). It specifies the columns that will appear in the report. You can customize
the report as per your choice. Just click “Add Entry” to add more columns.
Note: Depending on the size of the browser window, not all columns may be visible. In
this case, click on “Show Details” in order to see all columns.
For each column, you can define the following:

= Property
Indicates the field to be added as a report column.

»  Expression for Label
Defines an expression for the column header.
Note: If there is a value selected in the “Property” field, the name of the property is
used as a header for the column by default and there is no need to define a custom
value for the field “Expression for Label”. If you define an expression manually, this
expression will be used as the column header instead.

= Type of Column
Defines the desired column type.

»  Expression for Valve
Defines an expression for computing the value of the cell.
Note: If there is a value selected in the “Property” field, the name of the property is
used as a header for the column by default and there is no need to define a custom
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value for the field “"Expression for Value”. If you define an expression manually, this
expression will be used instead.

= Width
Defines the desired column width if necessary.

o Filter for “Object Classes and Categories for Additional Report Columns”
Appears once the report content has been specified. It defines the filter for the field
“"Object Classes and Cateqgories for Additional Report Columns “.

o Object Classes and Categories for Additional Report Columns
Appears once the report content has been specified. It is typically used for adding
multiple columns at once to the report. If for example the filter “Categories” has been
selected in the above field all columns of the Category will be added to the generated
report.

o Optimize Memory Usage
Optimizes memory usage. It is recommended to activate this option in case of
extensive reports. If activated, dynamic content of the report template is not handled.

o Store Report Result in Personal Dashboard
Stores the generated report in the “Report Results” widget of the Personnel File
dashboard independently of the selected scope (as a result the action that generates
the report can appear for example in the menu of each shelf and once executed, the
generated report will be listed in the “Report Results” widget of the Personnel File
dashboard and not of the Personnel File shelf).

6. Right-click the newly created report template and in the context menu that appears, select
“Release for Usage” to make the template available for use.

7. Navigate to the scope you selected (see field “Scope of Analysis” above). You will notice in
the left menu a new action for the report generation. Click this action to generate an Excel
report. All generated reports are listed in the “Report Results” widget of the corresponding
scope, which becomes available once the first report is created.

Notes:

*  You canimport column definitions or formats into a report if a correspondingly designed
Excel worksheet already exists. To do this, navigate to the desired report template in the
configuration, select either the "Import Column Definitions" or "Import Column Formats"
action in the context menu, and import the desired worksheet.

« Alternatively, you can also change the column format using a report result. To do this,
navigate to the desired report, download it using the context menu command, create the
desired column formats and then upload the worksheets again. Then select the action
"Take Column Format " in the context menu to apply the changes to the report template.

17.2.2.2 Creating a BIRT Report

In order to define a BIRT report read the White Paper “Fabasoft Integration for Eclipse BIRT".
This document provides instructions for the configuration and subsequent handling of Eclipse
BIRT as well as an example for the structure of the report.

Once you have created and exported a BIRT report file, proceed as follows:
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Navigate to the Personnel File configuration.

Click the "Reports and OData Services” widget.
Click “Create Report Template” in the left menu.
From the dialog that pops up, select “BIRT Report”.

Fill in the provided fields to specify the attributes of the generated report and then click

“Next”. The provided fields are as follows.

o

Multilingual Name
Defines the name of the report. You can define a report name in multiole languages.

Report Language

Defines the language of the report content (e.g. the column headers). Note that if you
select a report language, e.q. English, the action that generates the report will only be
available to users with the same Ul language setting, i.e. the English Ul in this example.
If you want this action to be visible in every Ul just leave the field emply.

Report Locale
Defines the locale of the report which determines for example the date format etc.

Format of the Report
Defines the desired output format of the report.

Scope of Analysis

Defines for which objects the action for generating the report will be available. If for
example, the scope of analysis is the Personnel File shelf, the action will be offered only
within each shelf and the generated report within a shelf will include objects of this
shelf only. In contrast if you wish to create a report that will contain all objects in
Personnel File, the Personnel File dashboard should be selected instead. In this case,
the action for generating the report will appear in the Personnel File dashboaro.

Note: If you select the personnel file shelf as the scope of analysis, the action will be
available within every shelf. If you want the action to appear only within a specific
shelf, navigate into this shelf, go to " Templates and Presettings” and Click the “Reports
and OData Services” widget. Then the procedure proceeds in the saome way.

Content of the Report
Defines what will be displayed in the report. The offered report content types vary
based on the selected scope of analysis.

Include Release Versions Only
Excludes draft versions of objects.

Exceptions for Release Versions

Appears once the "/Include Release Versions Only’ option is activated. You can enter
object types in this field (or enter an asterisk (*) to search), which are to be included in
the report even if they are in a draft state.

Include Valid Objects Only
Includes objects in the search that are currently valid. Note that object validity can be
restricted through the properties “Valid From” and “Valid Until”.

Filter Values
Indicates that the result values of the report will be Filtered.
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o Expression for Filtering Values
Appears once the “Filter Values” option is activated. It defines an app.ducx expression
that filters the result values, which will be included in the report.

o Restrict Report Creation to
Restricts the ability to generate the report to specific members.
Note: If you want to define a restriction, it is recommended that you add yourself to the
list temporarily in order to test and adjust the report after creating it. Remove yourself
from the field afterwards.

o Store Report Result in Personal Dashboard
Stores the generated report in the “Report Results” widget of the Personnel File
dashboard independently of the selected scope (as a result the action that generates
the report can appear for example in the menu of each shelf and once executed the
generated report will be listed in the “Report Results” widget of the Personnel File
dashboard and not of the Personnel File shelf).

o Report Info
Defines values for the properties “Key”, “Label” and “Value".
Note: If these properties have values, they are fetched during report creation and are
integrated into the XML that is committed to the BIRT report. They are contained in the
node info (Under the main node data) with any further nodes stemming from the
property “Key".

o Content
Attaches the file containing the BIRT report template.

6. Right-click the newly created report template and select “Release for Usage” in the
context menu that appears to make the template available for use.

7. Navigate to the scope you selected (see field “Scope of Analysis” above). You will notice in
the left menu a new action for the report generation. Click this action to generate a BIRT
report. All generated reports are listed in the “Report Results” widget of the corresponding
scope, which becomes available once the first report is created.

17.2.3 Create Personnel File Shelf

With the “Create Personnel File Shelf” action you can create a personnel file shelf. More
information can be found in chapter 17.3 “Personnel File Shelf”.

17.2.4 Create Applicant File Shelf

With the “Create Applicant File Shelf” action you can create an applicant file shelf.

17.2.5 Create Business Case Shelf

With the “Create Business Case Shelf” action you can create a business case shelf.

17.2.6 Import Predefined Values

Predefined values for assignments (like employment type) can be imported and updated using
a CSVfile..
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To import predefined values, perform the following steps:

1. Click the “Import Predefined Values” action.

2. Optionally, click the “Download CSV Template” to retrieve a template that describes the
necessary data structure.

3. Enterthe path to the CSV file in the Contentfield.

4. Click "Start Import”.

5. After the import has finished click “Next”.

The CSV columns are in general free-text fields of type string, number or date. Following CSV

columns are available:

CSV Column Field Possible Value
1d Import ID String
Class Reference Reference of an object class
(EmployeeCompany,
EmployeeLocation)
Name Name String
Description Description String
Street Address (Street) String
zipCode Address (Zip Code) Number
City Address (City) String
State Address (State) String
Country Address (Country) String
Emaill E-Mail Address (Topic: E-Mail1)  String
Email2 E-Mail Address (Topic: E-Mail 2)  String
Email3 E-Mail Address (Topic: E-Mail 3) String
Phone Telephone Numbers (Topic: String
Business)
Fax Telephone Numbers (Topic: Fox)  String
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CommLanguage

ContainerId

Language for Communication

Import ID of the container
(Personnel Area or Employee
Group)

Reference of a system language

(e.9. LANG GERMAN, LANG ENGLISH)

String

Note: The CSV columns “Street” to “CommLanguage” are only relevant for companies and

locations.

17.2.7 Import Categories

Categories can be imported and updated using a CSV file..

To import categories, perform the following steps:

1. Inthe personnel file configuration navigate in the “Categories” area.

2. Click the “"Import Categories” action.

3. Optionally, click the “Download CSV Template” to retrieve a template that describes the
necessary data structure.

4. Enter the path to the CSV file in the Contentfield.

5. Click “Start Import”.

6. After the import has finished click “Next".

The CSV columns are in general free-text fields of type string. Following CSV columns are

available:

CSV Column Field Possible Value

Id Import ID String

Name Name String

PersonnelFileShelf Fqbasphere ID or Import ID String (category is stored in the
td (Personnel File Shelf) personnel file shelf)
RetentionWorthy Retention Worthy Boolean value (true or false)
RetentionPeriod Retention Period

RetentionBaseDate

Base Date for the Beginning of the
Retention Period

Reference of a time interval (e.q.
FSCSCHEDULE@1.1001:TimeInterva

130Y00MO0WOODOOHOOMOOS)

Reference of a property (e.q.
FSCSCHEDULE@1.1001:CreatedAtDa

teTimeDef)

Fabasoft
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UsableFor

CategoryACL

CatSecChange

CatSecRead

OverrideKeys

Applicable for

Default ACL for Objects With This
Cateqgory

Change Access for Objects With
This Category

Read Access for Objects With This
Category

Reference of an object class (e.g.
FSCPERSONNELFILE@1.1001:Person

nelFileDocument)

Reference of an ACL (e.q.
FSCPERSONNELFILE@1.1001:RoomPe

rsonnelFileEmployeeACL)

E-Mail address of a user

E-Mail address of a user

CSV columns of properties to be
overwritten separated by commas
(otherwise empty values are
ignored and values are added in
list properties)

17.2.8 Import Folder Structure

Personnel file folder templates can be imported and updated using a CSV file.

To import personnel file folders, perform the following steps:

1. Inthe personnel file configuration navigate in the “Folder Structure for Personnel Files”

areaq.

2. Click the “Import Personnel File Folders" action.

3. Optionally, click the “Download CSV Template” to retrieve a template that describes the
necessary data structure.

4. Enter the path to the CSV file in the ContentField.

5. Click “Start Import”.

6. After the import has finished click “Next”.

The CSV columns are in general free-text fields of type string. Following CSV columns are

available:

CSV Column Field Possible Value

1d Import ID String

Name Name String

PersonnelFileShelf Fgbasphere ID or Import ID String (personnel file folder is

td (Personnel File Shelf) stored in the personnel file shelf)
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ParentId Import ID (superordinate String

personnel file folder)

DefaultCategory Default Category Import ID of a category
Categories Available Categories Import ID of a category
OverrideKeys - CSV columns of properties to be

overwritten separated by commas
(otherwise empty values are
ignored and values are added in
list properties)

17.2.9 Settings

Besides the settings in the dashboard the “Settings” action provides following possibilities:

“"General Settings” tab

Name
The name of the configuration.

Subject
Defines an additional description of the configuration.

Mindbreeze InSpire Service

If Mindbreeze InSpire services for the classification of documents are available in your
organization, here you can select a service, which is used when storing documents in a
personal file. If you do not select one, no classification is performed.

Note: The service only applies when documents are directly placed in a personal file. For
example, if you register a document that is assigned to a Teamroom using the context
menu command, the service defined in the Teamroom or the default service (when not
defined) is used.

Holiday Table
Defines the holiday table to be used in the configuration context (otherwise the default
holiday table is used).

Restrict Shortcuts Within Teamroom
Defines which type of shortcuts may be stored in the configuration.

Restrict the Downloading or Opening of Content on the Device
Allows to restrict team members who can open or download content on the device.

Restrict Team Members
Defines the organizations, organizational units, teams and external organizations whose
members may be added to the configuration.

Main Administrator

Defines the user who will receive the automatically generated e-mail messages
concerning the configuration. Otherwise, all app administrators receive the e-mail
messages. The user is also listed as contact in case of missing permissions.
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Support Team
The support team handles the organization-internal management of support requests in
the respective context.

Enable Advanced Mode
Advanced mode includes, for example, working with multiple shelves, as well as
managing templates and presettings.

Activate Trace Output

For example, as a form designer, when you use expressions for calculation or validation, it
can sometimes be difficult to identify errors in the expressions. To simplify analysis, you
can write trace output to the web browser console (cooobj.Trace ("string") ; Of

cooobj.Trace ("string", wvalue);).

“Personnel File Configuration” tab

Show “Pre-Capture” Action
Defines whether the barcode scan functionality is available.

Scan Documents as
Defines the document type (PDF or TIFF) of the pre-captured document.

Root Structure is Extensible
Defines whether personnel file folders can be manually added to personnel files at top
level (additionally to the predefined structure).

Make the Use of Personnel File Documents Mandatory
Determines whether documents in the personnel file can only be registered as personnel
file dJocuments.

Keep a Copy of the Personnel File When Changing the Assignment
Defines whether a copy of a personnel file is kept in the current personnel file shelf when
the assignment is changed.

Externally Managed Master File Data

To prevent that fields (that should be updated by an import or via the SAP integration) are
changed directly in the personnel file using the web environment, it is possible to set the
corresponding fields read-only. This applies only to personnel files for which the
“Managed Externally” option is enabled.

Transfer Changes in the Master Data to Other Personnel Files of the Same Person
Defines whether master data in personnel files that affect the same person should be
transferred when changes are made.

You can define a key for identifying the personnel files and the master data to be
transferred. The selected master data is only synchronized for active personnel files.

Enable E-Mail Notification for Birthdays
Defines whether e-mail notifications for birthdays are sent to the defined supervisors and
additionally defined e-mail addresses.

Send E-Mail Notification to Supervisors (Birthdays)
Defines whether e-mail notifications are sent to none, direct or all supervisors.

Further E-Mail Recipients (Birthoays)
Defines the e-mail addresses (one per line) to which the notifications should be sent.
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E-Mail Recipients (No Birthdays on the Next Day)
Defines the e-mail addresses (one per line) to which a notification is to be sent that no
employees have a birthday on the next day.

Enable E-Mail Notification for Anniversaries
Defines whether e-mail notifications for anniversaries are sent to the defined supervisors
and additionally defined e-mail addresses.

Send E-Mail Notification to Supervisors (Anniversaries)
Defines whether e-mail notifications are sent to none, direct or all supervisors.

Further E-Mail Recipients (Anniversaries)
Defines the e-mail addresses (one per line) to which the notifications should be sent.

Language for Birthdays and Anniversaries
Defines the language in which the in which the reports are generated and notifications
are sent.

Locale for Birthdays and Anniversaries
Defines the locale in which the in which the reports are generated and notifications are
sent.

“"personnel File Access” tab

Permanent Access for Employees
Defines whether the user for employee access is taken from the organizational structure.

Permanent Access for Supervisors
Defines whether the users for supervisor access are taken from the organizational
structure.

Changes in the Organizational Structure Regarding the Personnel File Access Are
Confirmed by

The specified user can confirm changes in the organizational structure regarding the
personnel file access via the workflow.

Information about Changes in the Organizational Structure Is Provided by

The specified users receive an activity via the workflow when the organizational structure
changes, a new organizational position or organizational unit is created or when an
object in the organizational structure is deleted.

Delete Structural Change Objects After

Structural change objects that are created by changing the organizational structure
should only be removed after a certain period of time. The time period can be defined in
this property.

Note: User-defined time periods can also be used, but these must be at least one month
long.

Self-Managed Master Data

The selected master data can be edited by the user who is assigned to the personnel file.

Members/Employees Can Upload Documents
Defines whether employees are allowed to upload documents in their own list, which can
subsequently be reqgistered by a personnel file user.
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o Default Process for Uploaded Documents
The defined process is automatically started on documents uploaded by employees.

e Actions in Dashboard
Defines actions to create form objects which are displayed in the personnel file access
dashboard.
Procedure: To do this, define the required form in the Forms and Categories area of the
configuration and release it for use. The form can be used in the Actions in Dashboard
field. In addition, define a title and a symbol for the action. Select a personnel file folder in
which the created objects are to be stored. The personnel file folder must have a default
category that allows users with access to store objects (Change Access for Objects with
this Category). The Expression for Determining the Visibility field can be used to define for
whom the action is displayed. The Navigate Into the Document After Creation property
can be used to specify that the form is navigated to directly after it has been created.

o Permissions for Temporary Access
The defined permissions are offered for selection when granting temporary access. The
access right (“No Access”, “Read Access” and “Change Access”) can be defined per
category.

o Organizational Structure Linked
Indicates whether the organizational structure of the organization is already linked to the

personnel file. If this is not the case, functionalities related to the organizational structure,
such as “Import Organizational Structure”, are not available in the personnel file.

“Numbering” tab

o Check Uniqueness of Personnel Numbers Across All Personnel File Shelves
Defines whether the uniqueness of personnel numbers is checked across all personnel file
shelves or only within one personnel file shelf.

o Generate Personnel Number Automatically
Determines whether the personnel number is automatically generated. If not, the
personnel number must be entered manually when creating a personnel file.
Note: If personnel numbers are automatically generated, no new personnel files can be
created by the import mechanism.

o Last Used Number
The defined number plus one is assigned to the next created personnel file.

e Format String
The number of zeros entered specifies the number of digits in the personnel number.

e Format Prefix
A string that precedes the personnel number.

o Used Formal Prefixes
Shows an overview of format prefixes the have been used by now.

“"Assignments” tab

e Activate Company
Defines whether companies can be managed in the configuration and used in personnel
files and applicant files.

Fabasoft Fabasoft Talents 77



Activate Location
Defines whether locations can be managed in the configuration and used in personnel
files and applicant files.

Activate Personnel Area
Defines whether personnel areas and personnel sub areas can be managed in the
configuration and used in personnel files and applicant files.

Activate Employee Group
Defines whether employee groups and employee circles can be managed in the
configuration and used in personnel files and applicant files.

Activate Organization Key
Defines whether organization keys can be managed in the configuration and used in
personnel files and applicant files.

"Consistency Check” tab

Enable Consistency Check

Defines whether a consistency check is performed reqularly in the background for all
personnel files. The check is also performed when a document is added to or removed
from a personnel file.

Rules for the Consistency Check

Defines the rules for the consistency check. You can use a rule to check whether a
document with the defined category exists in every personnel file. In addition to the
category, other conditions can also be defined for the document.

Category of the document
Defines that a document with this category must exist.

Restrict Scope
Only personnel files assigned to a position that has one of the defined companies and
one of the defined locations are taken into account for the consistency check.

Check Personnel File Folder of the Document
Defines that the document must be in one of the defined personnel file folders.

Check Validity of the Document
Defines that the document must be valid (Valid From and Valid to).

Check Age of the Document (Created on/at)
Defines that the creation date of the document must not be older than the defined time
span.

Rule May Be Ignored for Certain Personnel Files
Defines whether the rule can be disabled for individual personnel files.

Name
The name of the rule.

“SAP Settings” tab

The HR master data of the current employee can be displayed via the PA30 transaction in SAP.
On this tab you can define the necessary connection parameters. Consult your SAP
administrator to inquire the settings.
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Note: These settings allow opening the HR master data in SAP starting from the Fabasoft
Personnel File ("Open SAP HR Master Data” context menu command). The SAP integration
however allows opening the personnel file starting from SAP (see chapter 17.10 “SAP
Integration”).

“Skills Management” tab

On this tab, you can define a user who confirms further trainings. You can also manage the
rating scales for qualifications.

Note: Only visible if skills management is used.
“"Applicant Management” tab

On this tab, you can define the default category for applicant files in the talent pool. In
addition, you can define application sources as terms. The Enable Website Integration option
enables the automatic creation of applications via an HTML form. This gives the user for
website integration access to the personnel file configuration and the applicant file shelves. In
the Information Text That Is Displayed When the Applicant Is Accepted list, fFormatted
information texts can be defined for different languages that are displayed to a supervisor
during the “Accept” work item of the “Conduct Interview” activity.

“"Logos” tab

The defined logos and the background image are used for the personnel file configuration and
for all personal dashboards.

“"Default Values” tab

»  Default Thesaurus for New Terms
If o default thesaurus is specified, new terms can be created directly during tagging.

o Default Categories
When an object is created, the specified category is assigned according to the defined
object class. In the Apply tofield, you can specify whether the setting applies to
instances, templates, or both.

o Default Processes
When an object is created, the specified process is assigned according to the defined
object class or category. In the Apply tofield, you can specify whether the setting applies
to instances, templates, or both.

o Default Background Tasks
When an object is created, the specified background tasks are assigned.

o Release Process for Templates and Presettings
In order to use templates, text modules, forms and categories, processes and presettings,
they must be released. If a process is to be used for the release, a BPMN process diagram
can be defined here. Release processes must contain the "Release for Usage" activity.

“"Content Settings"” tab

On this tab you can define whether a generated cover sheet should be added to PDF overviews
of documents.
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In addition you can define watermark settings. With the Watermark for All Users option you
can test the settings by yourself. The settings also apply to the assigned personnel file shelves,
if they do not define their own settings.

If you use watermarks, the PDF overview of a personnel file will be watermarked. In addition
users with read access do not see the original documents of a personnel file but the
corresponding converted and watermarked PDF documents.

17.2.10 Define Permissions

To enable users to use the personnel file, they must be authorized in the personnel file
configuration. On the basis of the specified users the consumed licenses of the respective
service packages are calculated.

* Full Control (read-only)
The owner and co-owners of the organization have full access.

»  Personnel File Administrator
Personnel file administrators can edit the personnel file configuration. Users get the
service package “Fabasoft Personnel File”.

e Personnel File User
Personnel file users are entitled to use the Fabasoft Personnel File. The respective rights
are defined in the personnel file shelves. Users get the service package “Fabasoft
Personnel File".

o Personnel File Access
The access right allows read access to personnel files. Users get the service package
“Fabasoft Personnel File (Access)"”.

»  Skills Management
The skills management allows managing qualifications, job and role descriptions and the
generation of overviews of missing qualifications of employees. Users get the service
package “Skills Management”.

* Applicant Management
The applicant management allows managing applicant files, job advertisements and job
applications.

17.3 Personnel File Shelf

The personnel file shelf is based on a personnel file configuration, but the defined settings can
be overwritten or extended. The personnel file shelf is used to manage the personnel files and
to specify the access rights.

Settings made in the personnel file shelf override settings of the personnel file configuration
(exception: "Extensions” tab).

“"General Settings” tab

e Name
Defines the name of the personnel file shelf.

o Subject
Defines a further description.

Fabasoft Fabasoft Talents 80



*  App Configuration
The personnel file shelf inherits the settings of the assigned app configuration.

o Mindbreeze InSpire Service
If Mindbreeze InSpire services for the classification of documents are available in your
organization, here you can select a service, which is used when storing documents in a
personal file. If you do not select one, either the service defined in the personnel file
configuration is used (if defined) or no classification is performed.
Note: The service only applies when documents are directly placed in a personal file. For
example, if you register a document that is assigned to a Teamroom using the context
menu command, the service defined in the Teamroom or the default service (when not
defined) is used.

e Holiday Table
Defines the holiday table to be used in the shelf context.

o Restrict Shortcuts Within Teamroom
Defines which shortcuts can be stored in the personnel file shelf. Allows, for example,
storing cateqgories of user-defined forms.
Note: If you want to allow categories of user-defined forms, select “Default: Allow
shortcuts to all objects” because these categories are not assigned to any organization.

o Roles That Are Allowed to Open or Download Content on the Device
Defines which permissions a team member must have in order to open or download
content at the device.

o Restrict Team Members
Defines the organizations the team members have to belong to.

o Main Administrator
Defines the user who will receive the automatically generated e-mail messages
concerning the shelf. Otherwise, all shelf administrators receive the e-mail messages. The
user is also listed as contact in case of missing permissions.

e Support Team
The support team handles the organization-internal management of support requests in
the respective context.

e Activate Trace Output
For example, as a form designer, when you use expressions for calculation or validation, it
can sometimes be difficult to identify errors in the expressions. To simplify analysis, you
can write trace output to the web browser console (cooobj.Trace ("string") ; Of

cooobj.Trace ("string", value) ;).
“Personnel File Shelf” tab

e Calculate Statistics

Defines whether graphically processed statistics for the personnel files are shown in the
dashboard.

o Show “Pre-Capture” Action
Defines whether the barcode scan functionality is available.

e Scan Documents as
Defines the document type (PDF or TIFF) of the pre-captured document.
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e Root Structure is Extensible
Defines whether personnel file folders can be manually added to personnel files at top
level (additionally to the predefined structure).

o Make the Use of Personnel File Documents Mandatory
Determines whether documents in the personnel file can only be registered as personnel
file documents.

o Display of personnel files
Shows which type of personnel file display is currently being used for the personnel file
shelf. Either "Use Saved Lists for Personnel Files" or "Use Queried Lists for Personnel Files".

o Keep a Copy of the Personnel File When Changing the Assignment
Defines whether a copy of a personnel file is kept in the current personnel file shelf when
the assignment is changed.

o Externally Managed Master File Data
To prevent that fields (that should be updated by an import or via the SAP integration) are
changed directly in the personnel file using the web environment, it is possible to set the
corresponding fields read-only. This applies only to personnel files for which the
“Managed Externally” option is enabled.

e Enable E-Mail Notification for Birthdays
Defines whether e-mail notifications for birthdays are sent to the defined supervisors and
additionally defined e-mail addresses.

o Send E-Mail Notification to Supervisors (Birthdays)
Defines whether e-mail notifications are sent to none, direct or all supervisors.

o Further E-Mail Recipients (Birthdays)
Defines the e-mail addresses (one per line) to which the notifications should be sent.

e Enable E-Mail Notification for Anniversaries
Defines whether e-mail notifications for anniversaries are sent to the defined supervisors
and additionally defined e-mail addresses.

o Send E-Mail Notification to Supervisors (Anniversaries)
Defines whether e-mail notifications are sent to none, direct or all supervisors.

o Further E-Mail Recipients (Anniversaries)
Defines the e-mail addresses (one per line) to which the notifications should be sent.

o Language for Birthdays and Anniversaries
Defines the language in which in which the reports are generated and the notifications
are sent.

o Locale for Birthdays and Anniversaries
Defines the locale in which in which the reports are generated and the notifications are
sent.

"personnel File Access” tab

e Permanent Access for Employees
Defines whether the user for employee access is taken from the organizational structure.

e Permanent Access for Supervisors
Defines whether the user for supervisor access is taken from the organizational structure.
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o Changes in the Organizational Structure Regarding the Personnel File Access Are

Confirmed by
The specified users can confirm changes in the organizational structure regarding the
personnel file access via the workflow.

o Self~Managed Master Data
The selected master data can be edited by the user who is assigned to the personnel file.

o Members/Employees Can Upload Documents
Defines whether employees are allowed to upload documents in their own list, which can

subsequently be registered by a personnel file user.

o Default Process for Uploaded Documents
The defined process is automatically started on documents uploaded by employees.

“Numbering” tab

«  Generate Personnel Number Automatically
Determines whether the personnel number is automatically generated. If not, the
personnel number must be entered manually when creating a personnel file.

o LastUsed Number
The defined number plus one is assigned to the next created personnel file.

e Format String
The number of zeros entered specifies the number of digits in the personnel number.

e Format Prefix
A string that precedes the personnel number.

Note: If it is defined in the personnel file configuration that unique personnel numbers should
be used across all personnel file shelves, no specific settings can be made for the personnel
file shelves.

“"SAP Settings” tab

The master data of the current employee can be displayed via the PA30 transaction in SAP. On
this tab you can define the connection parameters. Consult your SAP administrator to inquire
the necessary settings.

“"Extensions” tab

o Addlitional Personnel File Folders
Defines personnel file folders in addition to the personnel file folders defined in the
personnel file configuration.

o Additional Rules for the Consistency Check
Defines rules for the consistency check in addition to the rules defined in the personnel file

configuration.

Note: If the personnel file shelf is unstructured, the additional rules for the consistency check
are currently not displayed.

“Logos" tab
The defined logos are used for the personnel file shelf.

“Default Values” tab
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o Default Thesaurus for New Terms
If o default thesaurus is specified, new terms can be created directly during tagging.

o Default Categories
When an object is created, the specified category is assigned according to the defined
object class.

o Additional Categories
Defines categories in addition to the categories defined in the configuration.

o Default Processes
When an object is created, the specified process is assigned according to the defined
object class.

o Additional Default Background Tasks
When an object is created, the specified background tasks are assigned.

"Content Settings” tab

o Allow Comments
Defines whether PDF comments can be applied to documents.

o Allowed Types for Comments
Defines the allowed types of comments (public or private).

e Preferred Type for Comments
Defines the type of comment initially selected when commenting (overrides the setting in
the configuration or user's basic settings).

o Users With Read Access Are Allowed to Comment Publicly
Defines whether users with read access are allowed to add public comments (overrides
the setting in the configuration).

o Allow Public Links
Defines whether public links may be published.

o Generate Cover Sheet for PDF Overviews of Documents
Defines whether a cover sheet is generated for PDF overviews of documents.

o Use Watermarks
If you use watermarks, the PDF overview of a personnel file will be watermarked. In
addition, users with read access do not see the original documents of a personnel file but
the corresponding converted and watermarked PDF documents.

17.4 Providing the Scan Functionality (Pre-Capture)

To provide the scan functionality, the scanner software must upload the document via a web
service to the Fabasoft Personnel Flle (see chapter 8.6 “Pre-Capturing a Document for a Scan”).

Use Case:

The user defines a document that should be scanned (identified by a barcode). The scanner
software reads the barcode on the paper document and sends the scanned file including the
barcode via a web service to the Fabasoft Personnel File. The document that has been defined
by the user gets populated with the scanned content.
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17.5 Creating Personalized Word Templates

To create personalized Word templates, metadata (e.q. salutation or address) of personnel
files can be inserted as updateable DocProperties or fields in Word documents. The “Insert
DocProperties” and “Insert Field” buttons are available in Microsoft Word on the “Fabasphere”
tab (the Fabasoft Folio COM Add-in has to be enabled).

17.6 Inbox

In an inbox, rules for the processing of incoming objects can be defined. A rule consists of
conditions and actions.

You can create the inbox directly on “Home" (background context menu > “New” > “Inbox”). As
for Teamrooms, you can also set permissions for inboxes to define the access rights.

For example, the documents can be stored in the inbox via WebDAV.

Assigning
Documents can be automatically replaced by incoming documents.

Create an inbox and define a rule. In the rule, define two actions. The first action “Assign
Category” is used to assign a category to incoming documents that has set the value
"Personnel File Document Incoming Category" as /ncoming Category for Registration. The
second action “Assign (Asynchronous)” is used to replace the documents. The replacement can
be based on QR codes (bulk documents) or PDF keywords. The Fabasphere /D (e.g. COO.
1.506.4.4063) of the document whose content is to be replaced by the incoming document
must be stored in the QR code or PDF keywords. For non-assignable documents, a further inbox
can be defined as target. In this inbox, a rule for starting a process for the manual assignment
can be defined (“Register” activity).

Classifying and Assigning Personal File Document

Incoming documents can be classified with Mindbreeze InSpire and then registered to a
personnel file based on the extracted metadata.

Create an inbox and define a rule. In the rule, define two actions. The first action “Classify With
Mindbreeze InSpire” is used to perform the classification with the specified Mindbreeze InSpire
service. The second action “Assign Personnel File Document (Asynchronous)” is used to register
the document to a personnel file. For non-assignable documents, a further inbox can be
defined as target. In this inbox, a rule for starting a process for the manual assignment can be
defined (“Register” activity).

For more information on defining the Mindbreeze InSpire Service, see chapter 17.9 “Classifying
With Mindbreeze InSpire”.

Import Data
The content of incoming CSV files can be imported automatically.

You can download templates for the CSV files via the respective manual actions (e.g. “Import
Categories” action of a personnel file configuration).
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Create aninbox and define a rule. In the rule, define an “Import Data” action. Define the target
for the import and the type of import (e.q. import personnel files).

17.7 Update Settings

Changes to the predefined folder structure and categories are not automatically applied to
existing personnel files and documents. The “Update Settings” context menu command of a
personnel file shelf or a personnel file can be used to apply the changes.

e Background Tasks
Changes to the Default Background Tasks of the personnel file configuration, personnel
file shelf and categories are applied.

* Follow-Ups
Changes to the Default Follow-Ups of the categories are applied.

* ACL Object (Access Rights)
The Default ACL for Objects with this Category of the category is applied, if an ACL is
defined.

» Folder Structure
Changes in the predefined folder structure are applied. This includes adding, removing
and modifying folders.
Removed predefined folders will be deleted, if they are empty. If not, the folder is marked
as not predefined and can therefore be handled manually (this behavior can be changed
by the next option such that contents are moved to the parent folder if possible).
When changing predefined folders the name, the subject, the default category and the
available categories are taken into account.

«  Move Documents From Deleted Folders to the Superordinate Folder
If predefined folders were removed, the corresponding folders will be deleted and the
content is moved to the superordinate folder. If the removed predefined folder is a top-
level folder, the folder will remain (if there is a content) and will be marked as not
predefined.

Note: The “Update Settings” context menu command is also provided for applicant file shelves
and applicant files. It can be used to update background tasks, follow-ups and ACL objects.

17.8 Perform a Consistency Check

If rules for the consistency check have been defined in the personnel file configuration orin the
personnel file shelf, a consistency check is performed reqularly in the background for all
personnel files. The check is also performed when a document is added to or removed from a
personnel file.

The consistency check can also be performed manually on a personnel file shelf or personnel
file using the “Perform Consistency Check” context menu command. Inconsistencies are
visualized in the affected personnel files or documents with a corresponding status symbol. A
list of all inconsistent personnel files can be found in the “Inconsistent Personnel Files” widget.

If you have defined that a rule may be ignored for individual personnel files, you can disable
the rule in the properties of the affected personnel file on the “Consistency Check” tab using
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the “Ignore Rule for This File” context menu command. To enable the rule again, you can use
the “Check Rule for This File” context menu command.

These functionalities are currently only available for structured personnel file shelves. The
consistency check is currently not available in unstructured personnel file shelves.

17.9 Classifying With Mindbreeze InSpire

To enable automatic classification with Mindbreeze InSpire, a Mindbreeze InSpire service must
be configured. Mindbreeze InSpire services can be created in the organization (*“Advanced
Settings”) and can be selected in the personal file configuration or personal file shelf. Contact
Mindbreeze InSpire Support to determine the specific settings for the service.

The following steps explain the basic operation:

1.

In a learning phase, Mindbreeze InSpire is trained to classify the documents. For the
extraction of the metadata from documents, reqular expressions can be defined.

In the productive mode, when executing the “Classify and Register” context menu
command or when directly storing documents in a personal file, the classification and the
metadata are requested from the Mindbreeze Inspire service.

For the classification value, a category with a corresponding import ID is searched and
assigned to the document.

Classify and register using the context menu

If a category is found that is defined in a personnel file configuration, reqgistration is started
as a personnel file document.

Classify and register by direct storage

Regardless of the category found, registration is started as a personnel file document.
Classify with an inbox

Classifying can also be carried out automatically via an inbox.

If metadata can be obtained from the document, it will be prefilled. The reference of the
respective property is used as key.

Note: If the Mindbreeze InSpire keys do not correspond to the personnel file keys, a
corresponding mapping must be defined in the Mindbreeze InSpire service.

The Fabasoft Personnel File provides the following keys for the automatic identification of a

personnel file:

Personnel File Key Description

FSCPERSONNELFILE_l_lOOl_pers fileshelfid personne[ ﬁle Shelf (Fobosphere 1D or -import

ID; optional)

FSCPERSONNELFILE_l_lOOl_pfpersnum personnel number
FSCPERSONNELFILE_l_lOOl_pfsocialsecid social Secur'ity number
COOSYSTEM 1 1 userfirstname First name
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COOSYSTEM 1 1 usersurname surnome

fullname first name and surname
FSCFOLIO 1 1001 persbirthday birth date
COOMAPI 1 1 emailaddress e-mail address

The evaluation is carried out in following order (if a match is made the remaining steps are not
executed):

1. FSCPERSONNELFILE 1 1001 pfpersnum

2. FSCPERSONNELFILE 1 1001 pfsocialsecid

3. COOSYSTEM 1 1 userfirstname, COOSYSTEM 1 1 usersurname and
FSCFOLIO 1 1001 persbirthday

4. fullname QNd FSCFOLIO 1 1001 persbirthday

5. COOMAPI 1 1 emailaddress

The Fabasoft Personnel File provides following key for classification:

Personnel File Key Description

COOTC 1 1001 objcategory category

The personnel file folder is determined via the category, but can also be defined via the
FSCPERSONNELFILE 1 1001 persfilefolderid key (Fabasphere ID or import ID).

17.10 SAP Integration

The SAP integration enables the following scenarios:

« Linking HR master data in SAP with the respective personnel files
» Storing payslips generated with SAP in the respective personnel files

» Export of the organizational structure from SAP and import to the Fabasoft Personnel File

17.10.1 Linking HR Master Data

The integration for linking HR master data is carried out with an own information type 9600
“Fabasoft Personnel File” (/FaBASOFT/ name space). Therefore, no direct modifications in SAP
are required and update-safety is ensured.

Setting up the SAP integration is divided into the following three steps:

« Importing certificates
* Importing transport requests

« Configuration
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17.10.1.1 Importing Certificates

For communication with the Fabasoft Personnel File, the corresponding CA certificates must
be stored with the SAP SSL Server.

To import the CA certificates, perform the following steps:

1. Navigate in your web browser to the Fabasoft Personnel File.

2. You can view the certificate hierarchy via the address bar of the web browser.

g | Certificate X

General Detsils Certification Path

Certification path
5] SwissSign

3. Save all CA certificates of the hierarchy to a file. In the following, these certificates are
imported into SAP.
Note: In the case of the Fabasphere save both SwissSign CA certificates.

4, Switch to the SAP GUI.
5. Runthe STRUST transaction.

6. If no “SSL Server Standard” is configured, create one with the “Create” context menu
command.

7. Switch to edit mode.

8. Inthe Certificate field, you can import a CA certificate with the “Import Certificate” button
and add it to the trusted certificates with the “Add to Certificate List” button. Repeat this
step for all CA certificates of the Fabasoft Personnel File certificate hierarchy.

9. Save the changes.

17.10.1.2 Importing Transport Requests
The linking of HR master data requires two transfer requests, which can be downloaded here:

Transport Requests (Fabasoft Personnel File - SAP Integration): Linking HR Master Data

Pass the files to your SAP administrator, who can use the STMS transaction (Transport
Management System) to import the transport requests and forward them, according to your
compliance rules, to your production system.

Note: Before importing, make sure that the information type 9600 is not already used in your
system. If this is the case, please contact the Fabasoft Support.

17.10.1.3 Configuration

After a successful execution of the transport requests, you need to configure the URLs of the
Fabasoft Personnel File in SAP.
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To carry out the configuration in SAP, perform the following steps:

1. Switch to the SAP GUI.

2. Run the SM30 transaction.

3. Inthe Table/Viewfield enter “/FABASOFT/PERSF” and click “Display”.
4. Switch to edit mode.

5

Define the following values:

URL PERSFILE folio/personnelfie/

URL [PROTOCOL https://

URL WEBSRVC folio/ fscdav/wsd?WEBSYC=FSCPERSONNELFILE_1_1001_WebServicesPersonnelt
URL WEBSRVC DOMAIN at.cloud. fabasoft.com/

O PERSFILE
By default (valid for the Fabasphere):

folio/personnelfile/

O WEBSRVC

By default (valid for the Fabasphere):
folio/fscdav/wsdl?WEBSVC=FSCPERSONNELFILE 1 1001 WebServicesPersonnelFile

O WEBSRVC DOMAIN

By default (valid for the Fabasphere, location Austria):
at.cloud.fabasoft.com/

If you use the personnel file in a different location, enter the appropriate URL.

6. Save the changes.

Note: If you have also imported the transport request for storing payslips, additional
configuration settings are available that are not used in this scenario.

17.10.2 Storing Payslips
SAP-generated payslips can be automatically stored in the respective personnel file.
Setting up the SAP integration is divided into the following four steps:

« Importing Certificates
« Activating HR Forms
e Importing Transport Requests

» Configuration

17.10.2.1 Importing Certificates

For communication with the Fabasoft Personnel File the corresponding CA certificates must be
stored with the SAP SSL Server. If you have not yet done so, perform the steps described in
chapter 17.10.1.1 “Importing Certificates”.

17.10.2.2 Activating HR Forms

Make sure that the HR form you are using for payslips is activated. For technical reasons, the
HR form sap_paysLIP AT must also be activated.

To activate an HR form, perform the following steps:
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Switch to the SAP GUI.

Run the HRFORMS transaction.

Open the “Utilities” menu and execute the "Activate Forms" command.
Select the desired HR form.

Select the “"Generate structure and program” option.

o o b~ W D H

Click "Execute”.
Note:

« The HR forms must be activated before the transfer request for storing payslips is
imported.

e The activation must be carried out on all systems on the transport path on which the HR
forms are tested or used.

17.10.2.3 Importing Transport Requests

It is required that the two transport requests for linking HR master data have been imported
(see chapter 17.10.1.2 “Importing Transport Requests”).

In addition, the transport request for storing payslips must be imported. This transport request
can be downloaded here:

Transport Requests (Fabasoft Personnel File - SAP Integration): Storing Payslips

17.10.2.4 Configuration

Once the transfer requests have been successfully executed, the report
/FABASOFT/VDN2RECM INIT must be executed once on the respective systems. In the Form field,
enter the HR form you are using for the payslips and execute the report.

Note: If you want to use a different HR form, the initialization report must be executed again.
Finally, you must perform the following configuration steps:

1. Switch to the SAP GUI.
Run the SM30 transaction.

2
3. Inthe Table/Viewfield enter “/FABASOFT/PERSF” and click “Display”.
4. Switch to edit mode.

5

Define the following values:

O PERSFILE
By default (valid for the Fabasphere):
folio/personnelfile/

O VDNDOCTYPE
Defines the external key of the category that should be assigned to the payslip.

O VDNFILE

By default (valid for the Fabasphere):
folio/uploadpfdocument/
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o0 VDNPFREGISTER
Defines the external key of the personnel file folder in which the payslip should be
stored.

O VDNSTATUS

Defines the document state: PersonnelFileDocumentInProgress Of
PersonnelFileDocumentClosed

O WEBSRVC

By default (valid for the Fabasphere):
folio/fscdav/wsdl?WEBSVC=FSCPERSONNELFILE 1 1001 WebServicesPersonnelFile

O WEBSRVC DOMAIN

By default (valid for the Fabasphere, location Austria):
at.cloud.fabasoft.com/

If you use the personnel file in a different location, enter the appropriate URL.

6. Save the changes.

17.10.3 Export and Import of the Organizational Structure

A CSV file describing the organizational structure can be generated from the organizational
chart and employee master data available in SAP. The organizational structure can be
transferred using the import mechanism of the Fabasoft Personnel File.

17.10.3.1 Importing the Transport Request

The transport request needed for exporting the organizational structure can be downloaded
here:

Transport Requests (Fabasoft Personnel File - SAP Integration): Exporting Organizational

Structure

Pass the files to your SAP administrator, who can use the STMS transaction (Transport
Management System) to import the transport requests and forward them, according to your
compliance rules, to your production system.

18 Interfaces

The Fabasoft Personnel File provides following interfaces for the communication with third-
party products.

18.1 URLs

The following friendly URLs are available.

Presenting a Personnel File
To present a personnel file, for example, in a web browser you can use the following URLs:

Access based on the personnel number
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https://<server>/<vdir>/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1.396257
&shelfid=<Fabasphere ID or Import ID of the personnel file shelf>
&persnum='<personnel number>'

https://<server>/<vdir>/personnelfile/<personnel number>/<Fabasphere ID of the
personnel file shelf>

Parameters:

. shelfid
Fabasphere ID of the personnel file shelf.

® persnum
Personnel number of the personnel file to be opened.

https://at.cloud.fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1
.396257&shelfid=C00.1.3285.3.19&persnum="'00001"

https://at.cloud.fabasoft.com/folio/personnelfile/00001/C00.1.3285.3.19

Access based on the user ID

https://<server>/<vdir>/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1.396256
&shelfid=<Fabasphere ID or Import ID of the personnel file shelf>
&userid=<Fabasphere ID or e-mail address of the assigned user>

https://<server>/<vdir>/personnelfile/
Note: Personnel file of the currently logged in user.

https://<server>/<vdir>/personnelfile/<Fabasphere ID or e-mail address of the
assigned user>/<Fabasphere ID of the personnel file shelf>

Parameters:

. shelfid
Fabasphere ID of the personnel file shelf.

. userid
Fabasphere ID of the user who is assigned to the personnel file. If the userid is not
defined, the system tries to identify a personnel file that is assigned to the currently
logged in user.

https://at.cloud.fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1
.396256
Note: Personnel file of the currently logged in user.

https://at.cloud.fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1
.396256&shelfid=C00.1.3285.3.19
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https://at.cloud.fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1
.396256&shelfid=C00.1.3285.3.19&userid=cadence.jones@fabasoft.com

https://at.cloud.fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1
.396256&shelfid=C00.1.3285.3.19&userid=C00.1.3285.1.15

https://at.cloud.fabasoft.com/folio/personnelfile/
Note: Personnel file of the currently logged in user.

https://at.cloud. fabasoft.com/folio/personnelfile/cadence. jones@fabasoft.com/C0O0.1
.3285.3.19

Uploading a Document

To upload a document in a personnel file you can use following URL:

https://<server>/<vdir>/uploadpfdocument/<personnel number>/<Fabasphere ID of the
personnel file shelf>/<document name with file extension>/<external key of the
category>/<external key of the personnel file folder>/<valid from: yyyy-mm-
dd>/<valid until: yyyy-mm-dd>/<document state: PersonnelFileDocumentInProgress
oder PersonnelFileDocumentClosed>

The document must be delivered in the HTTP body. The parameters “personnel number”,
“document name with file extension” and the content of the document are mandatory. If no
personnel file folder but a cateqgory is defined, it is tried to determine the personnel file folder
via the category. If no unambiguous personnel file folder can be determined, an error is
generated.

https://at.cloud.fabasoft.com/folio/uploadpfdocument/00002/doc.txt//HRDOCUMENT PAY
ROLL//2017-01-30/

18.2 Web Service

A web service is provided to upload documents and to create or read personnel files.

The WSDL can be accessed using the following URL:

https://<server>/<vdir>/fscdav/wsdl?WEBSVC=FSCPERSONNELFILE 1 1001 WebServicesPerso
nnelFile

The web service supports also the JSON format:

https://<host>/<vdir>/wsjson/FSCPERSONNELFILE 1 1001 WebServicesPersonnelFile/<oper
ation>

Operations:

. GetPersonnelFile
Retrieves a list of personnel files based on a personal number. If no personnel files can be
found a list of available personnel file shelves are returned.

Fabasoft Fabasoft Talents 94



. CreatePersonnelFile
Is used to create a personnel file with the given property values.

. UpdatePersonnelFile
Refreshes a personnel file. Single-valued properties are overwritten if they are specified.
To remove a value from a single-valued property, the property must not be specified and
be defined in overwriteattributes. Values of multi-valued properties are appended by
default. If they are defined in overwriteattributes they are overwritten. You can use
implicitcreateonupdate to specify whether a personnel file should be created, if no
personnel file with the specified combination of persnum and shelfid exists.
If it is defined in the personnel file configuration that unique personnel numbers should be
used across all personnel file shelves, existing personnel files can be moved by specifying
a different shelfid.

. UploadDocument
Is used to upload documents to a personnel file.

o UploadScannedDocument
Is used to upload scanned documents to the personnel file. To do so the personnel file
shelf and the barcode have to be submitted as parameter. The document is automatically
removed from the scan queue after a successful upload.

Note: The web service calls with the JSON format must be called using the HTTP request
method “POST".

Request JSON (GetpPersonnelFile):

{"shelfid":"C00.200.200.4.156", "persnum":"00000008"}
{"shelfid":null, "persnum":"00000000"}

Request JSON (CreatePersonnelFile):

{
"data": {

" ": "PersonnelFileData",

"shelfid": "C00.200.200.4.156",

"persnum": "10000001",

"firstname": "Martin",

"surname": "Peterson",

"socialsecid": "12345",

"sex": "1",

"supervisorid": "colin.steve@example.com",

"allsupervisors": [
{"supervisorid": "laura.hammond@example.com"},
{"supervisorid": "davis.baker@example.com"}

Request JSON (UpdatePersonnelFile):

{
"data": {
" ": "PersonnelFileData",
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"shelfid": "C00.200.200.4.156",
"persnum": "10000001",
"telephone": [ {
" ": "Telephone",
"telnumber": "4+43 664 12345"
Pl
"supervisorid": "laura.hammond@example.com",
"allsupervisors": [
{"supervisorid": "laura.hammond@example.com"},
{"supervisorid": "davis.baker@example.com"}

1,

"overwriteattributes": [
"telephone",
"supervisorid",
"allsupervisors"

Request JSON (UploadDocument):
{

"persnum" : "00001",
"shelfid" : "C00.1.506.4.3628",
"docname" : "Payroll 2017 12.txt",
"doctype" : "HRDOCUMENT PAYROLL",
"register" : "HRREGISTER_PAYROLL",
"validfrom" : "2017-01-02",
"validuntil" : "2017-12-15",
"docstate" : "PersonnelFileDocumentClosed",
"doccontent" : "RG9rdWllbnRpbmhhbHQ",
"params" : {
"objsubject" : "Payroll",
"COOSYSTEM@1l.1l:objexternalkey" : "extid",
"FSCTERM@1.1001:0bjterms" : ["C00.1.506.4.19119", "C0O0.1.506.4.19120"]

More information about the parameters of the operations can be found here:
https://help.developer.fabasoft.com/index.php. Search for the corresponding actions

(WSGetPersonnelFile, WSCreatePersonnelFile, WSUpdatePersonnelFile, WSUploadDocument,

UploadScannedDocument).
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